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Preface

Sun StorageTek Business Analytics software enables you to visualize and manage 
multi-vendor, multi-site storage environments. From one central location, you can 
discover storage assets, track storage utilization, recover lost capacity, and verify 
that data is protected, thereby reducing storage costs and improving operational 
efficiency.

How This Document Is Organized
Chapter 1 describes how to get started using Sun StorageTek Business Analytics 
web-based Management Console.

Chapter 2 describes the different reports available through the Management 
Console’s Assets pull down menu.

Chapter 3 describes the different reports available through the Management 
Console’s Storage pull down menu.

Chapter 4 describes the different reports available through the Sun StorageTek 
Business Analytics Management Console’s Fabrics pull down menu.

Chapter 5 describes the different reports available through the Management 
Console’s Backup/Restore pull down menu.

Chapter 6 describes the different reports available through the Management 
Console’s Servers pull down menu.

Chapter 7 describes the different reports available through the Management 
Console’s Databases pull down men.

Chapter 8 describes the different reports available through the Management 
Console’s Provisioning pull down menu on the home page.
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Chapter 9 describes the different reports available through the Sun StorageTek 
Business Analytics Management Console’s Help pull down menu.

Typographic Conventions

Related Documentation
The documents listed as online are available at:

http://www.sun.com/products/storage

Typeface*

* The settings on your browser might differ from these settings.

Meaning Examples

AaBbCc123 The names of commands, files, 
and directories; on-screen 
computer output.

Edit your.login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when contrasted 
with on-screen computer output.

% su

Password:

AaBbCc123 Book titles, new words or terms, 
words to be emphasized. 
Replace command-line variables 
with real names or values.

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do this.
To delete a file, type rm filename.

Application Title Part Number Format Location

Installation of the main 
product

Sun StorageTek Business Analytics 
Installation Guide

819-7181-10 Printed
PDF
HTML

Shipping 
kit
Online

Sun StorageTek Business Analytics 
Getting Started Guide

819-7190-10 Printed
PDF
HTML

Shipping 
kit
Online

Use of the Management 
Console administrative 
menu

Sun StorageTek Business Analytics 
Administration Guide

819-7183-10 Printed
PDF
HTML

Shipping 
kit
Online



Preface xi

Late-breaking information 
not included in the 
information set

Sun StorageTek Business Analytics 
Release Notes

819-7203-10 PDF
HTML

Online

Planning for customized 
implementations

Sun StorageTek Business Analytics 
Concepts and Planning Guide

819-7188-10 PDF
HTML

Online

Use of standard reports and 
reporting wizards

Sun StorageTek Business Analytics 
Management Console User’s Guide

819-7209-10 PDF
HTML

Online

Use of the database tables Sun StorageTek Business Analytics 
Application Developer’s Guide

819-7182-10 PDF
HTML

Online

Installation of agents Sun StorageTek Business Analytics 
Array Agents Installation Guide

819-7184-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
Backup Agents Installation Guide

819-7185-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
Library Agents Installation Guide

819-7186-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
Database Agent Installation Guide

819-7187-10 PDF
HTML

Online

Sun StorageTek Business Analytics Host 
Agent Installation Guide

819-7189-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
Remote Host Agent Installation Guide

819-7201-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
Fabric Agent Installation Guide

819-7205-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
NAS Agent Installation Guide

819-7206-10 PDF
HTML

Online

Sun StorageTek Business Analytics Host 
Statistics Agent Installation Guide

819-7207-10 PDF
HTML

Online

Sun StorageTek Business Analytics 
SRM Agent Installation Guide

819-7208-10 PDF
HTML

Online

Sun StorageTek Business Analytics Host 
and SRM Agent Release Note for Self 
Extracting Agent Install CD

819-7204-10 PDF
HTML

Online

Application Title Part Number Format Location
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Documentation, Support, and Training

Third-Party Web Sites
Sun is not responsible for the availability of third-party web sites mentioned in this 
document. Sun does not endorse and is not responsible or liable for any content, 
advertising, products, or other materials that are available on or through such sites 
or resources. Sun will not be responsible or liable for any actual or alleged damage 
or loss caused by or in connection with the use of or reliance on any such content, 
goods, or services that are available on or through such sites or resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and 
suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback

Please include the title and part number of your document with your feedback:

Sun StorageTek Business Analytics Management Console User’s Guide, part number
819-7209-10

Sun Function URL

Documentation http://www.sun.com/documentation/

Support http://www.sun.com/support/

Training http://www.sun.com/training/
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CHAPTER 1

Getting Started

This chapter describes how you get started using Sun StorageTek Business Analytics 
web-based Management Console. 

Note – Sun StorageTek Business Analytics was formerly called Global Storage 
Manager (GSM).

The reports shown in this manual are for discussion purposes only - your company’s 
reports will portray actual data, and will thus be somewhat different. The following 
topics are discussed:

■ “Logging In” on page 1

■ “Reset Password” on page 3

■ “Home Page” on page 3

■ “Dashboards” on page 5

■ “Dashboard Panes” on page 6

■ “Dashboard Administration” on page 11

■ “Introducing Sun StorageTek Business Analytics Reports” on page 13

■ “Sun StorageTek Business Analytics Report Items” on page 18

Logging In
To log in to the Sun StorageTek Business Analytics Management Console, you’ll 
need your user name and password. If you do not have a valid user name and 
password, contact your system administrator. Proceed as follows:

1. Launch your web browser.
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2. Enter the URL that your system administrator supplies to reach the Sun 
StorageTek Business Analytics Management Console Home Page.

3. The Sun StorageTek Business Analytics Management Console login window 
appears, similar to the following screen. The Utility Bar appears at the top of the 
login page and contains buttons with the following links:

■ Help - Click to display the Help-> Contents and Index window that allows you to 
select information using the Help engine.

■ Version - Click to display the Help -> About Business Analytics dialog window 
that shows the version of the Central Manager databases and the Management 
Console. 

FIGURE 1-1 Management Console Login Window
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4. Type your USER LOGIN and PASSWORD in the corresponding fields, and click 
Login. 

Your company’s Management Console Home Page appears.

Reset Password
If you forget your password, you may reset it as follows:

1. Click Password on the Login screen to access the Forget Your Password? window, 
as shown in Figure 2. 

FIGURE 1-2 Reset Password

2. Click the New Password button.

The new password is sent to your e-mail account and will only work once. You must 
change your password and record it for subsequent Management Console sessions. 

Home Page
The Sun StorageTek Business Analytics Management Console Home Page appears 
after you successfully log in to the application. Sun StorageTek Business Analytics 
provides a customizable Home Page (or personalized dashboards). A sample 
Management Console Home Page is shown below.
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FIGURE 1-3 Sample Manager Console Home Page

Home Page Cache Tables
Sun StorageTek Business Analytics implements a cache table for each dashboard 
pane that may be displayed on the Management Console home page. The data in the 
cache tables may be refreshed either by the scheduling of their related DB SQL batch 
job (Tools-> Database Administration -> DB Batch Job) or manually (Tools-> 
Database Administration -> Refresh Homepage Cache). This functionality is 
associated with the following assumptions and limitations:

■ The Policy Agent is running. 

■ The SQL batch jobs to refresh the home page cache should be configured to run as 
per the data collection schedule.

■ The cache table’s expiration period is two (2) days. If data is not collected for 
more than 2 days, the cache table data will expire. For reports, however, the 
expiration period is asset-specific and depends on the grace period (e.g., 3 days).

■ If the administrator back dates the time used by the database server, the Business 
Analytics user will need to manually execute Refresh Homepage Cache or wait 
for the Policy Agent to run the scheduled SQL batch job.

■ If the "gsa_homepage_cache_stats" table indicates the number of inserted rows for 
a cache table is equal to zero, the associated home page dashboard pane will not 
show any data. This indicates that either data is not present for the asset or there 
is some type of data insert error on the database side.
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■ A Business Analytics user will not see data in the dashboard panes on the home 
page immediately after data collection or a Central Manager Database Upgrade, 
You must wait until either the scheduled SQL batch job runs or the home page 
cache has been manually refreshed from the corresponding Tools menu selections.

■ If the data size is large and a Business Analytics administrative user is running a 
homepage cache update job manually, a server side script time out error may 
possibly occur. The time out can occur on the page because the IIS server time out 
is less than the execution time required for the SQL batch job. In this case, simply 
close the window. The SQL batch job will continue to run on SQL server. The 
Business Analytics user can see the updated data once the SQL batch job 
completes its execution. 

Dashboards
The Management Console supports personalized dashboards that you create using 
the Dashboard Administration menus. Each dashboard contains one or more panes 
that together represent a customized home page.

By selecting Tools → Change Dashboard you can choose any available dashboard as 
your current dashboard, as shown in Figure 4.

FIGURE 1-4 Change Dashboard

Proceed as follows:

1. Use the radio button to choose the desired dashboard in the table.



6 Sun StorageTek Business Analytics Management Console User’s Guide • June 2006

2. Click Set as Current dashboard. The following pop up dialog is displayed.

FIGURE 1-5 Default dashboard has been changed

3. Click OK. 

Your browser window will be refreshed and the selected dashboard will appear on 
your Management Console Home Page.

Dashboard Panes
The dashboard panes provide high-level information on a specific asset or 
application, as described below.

Host Filesystem Utilization - This pane allows you to quickly identify hosts with the 
least amount of available storage capacity for file systems.  Refer to FIGURE 1-6.

FIGURE 1-6 Host Filesystem Utilization
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As seen in FIGURE 1-6, the pie chart shows disk utilization for the top ten hosts. 
Holding the mouse over the pie chart displays the "Host Data Utilized for 
<Company Name or View → since dd/mm/yyyy GMT." text message. The pie chart 
and table are presented based on data collected for the current date.

The table presents the same information, but in tabular form. To obtain other host-
related information, use the Servers pull-down menu and click the report you wish 
to view.

Database Management - This pane summarizes how your databases are consuming 
storage. Refer to FIGURE 1-7.

FIGURE 1-7 Database Management

The pie chart shows the storage utilization for the specified number of databases or 
instances. Holding the mouse over the pie chart displays the "Database 
Configuration Information for <Company Name> between dd/mm/yyyy and 
dd/mm/yyyy" text message. This dashboard presents data collected over the past 
thirty days.

To the right of the pie chart, the database server, database, and consumed storage are 
displayed in a tabular format. When more detailed information is needed, use the 
Database pull-down menu and click the Database Configuration/Capacity report.

Storage Capacity Allocation Overview - This pane shows storage that has been 
allocated to SAN-connected host servers. Refer to FIGURE 1-8.
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FIGURE 1-8 Storage Capacity Allocation Overview

The pie chart displays the percentage of total capacity assigned, the percentage of 
overall capacity available, and the percentage assigned to local copies (BCVs). 
Clicking on the pie chart displays the Storage Allocation Overview report. This 
report provides the information displayed in the dashboard as well as the following 
items:

■ Definitions of terminology

■ Export button 

The table provides essentially the same data but also shows the percentage of 
storage assigned to remote copies. The Storage Array ID column is a report link that 
displays the Detailed Array Configuration report. The Asset Management report 
also provides access to displaying the Detailed Array Configuration report.

NAS Device Overview - This pane shows summary-level information on the 
utilization of storage resources on NAS devices. See FIGURE 1-9.

FIGURE 1-9 NAS Device Overview
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The table contains the following columns:

■ Device Name 

■ Capacity Used (GB)

■ Capacity Available (GB)

■ Snapshot Used (GB)

■ Snapshot Reserved (GB)

■ Total Capacity (GB) 

■ % Utilized [Capacity Used + Total Snapshot / Total Capacity]

A snapshot is a read-only copy of an entire file system, as of the time the snapshot 
was created. Both EMC Celerra and Network Appliance use a copy-on-write 
technique to create snapshots very quickly without consuming any disk space. Only 
as blocks in the active file system are modified and written to new locations on disk 
does the snapshot begin to consume extra space. Snapshot refers to the percentage of 
the overall file system space that has been reserved to store changed file system 
blocks.

The total Capacity is calculated as [Capacity Used + Capacity Available + Snapshot]. 
The % Utilized is calculated as [Capacity Used + Total Snapshot / Total Capacity]. 
The Total Snapshot variable refers usually to the Snapshot Reserved, but it could be 
the Snapshot Used if the Snapshot Used exceeds the Snapshot Reserved.

The pie chart shows the summary level NAS filesystem utilization for the current 
view. Holding the mouse over the pie chart displays the "Detailed nas data for 
<current_view> on <current_date> text message. Clicking on the pie chart displays 
the NAS Filesystem Utilization report. Clicking on the NAS device name link in the 
table displays the Detailed NAS Configuration report.

Backup Status Summary - This pane allows you to quickly identify unsuccessful 
backups for the listed NetBackup or Legato backup clients in the last twenty-four 
hours. The pie chart displays backup summary information on the backup client 
success rate for the backup infrastructure. Hold the mouse over the chart to display 
the start date for the data that appears in the chart. The possible statuses are 
described as follows:

■ Successful - Backup application returned a successful completion code.

■ Failed - Backup application returned a failure completion code.

■ Partial - Backup application returned a completion code other than 
successful/failure.

For Legato NetWorker, the status for a client on the home page is "partial" if that 
client had a combination of failed and successful jobs. For NetBackup, the status of a 
client is partial for all the following combinations:

■ Successful and partial jobs

■ All partial jobs
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■ Failed and partial jobs

■ Successful and failed jobs.

To the right of the pie chart is a table that lists more detail for the failed backup 
events represented in the pie chart. The table shows the failed backup client, the 
master server, and the client status.

The Backup Client Name report link displays the Detail Backup/Restore Job Logs 
for Client report. 

Tape Library Overview - This pane shows to what extent your tape library resources 
are being utilized. The pie chart displays the number of free cells, active cells, and 
total cells in the environment’s tape libraries. The percentage of free cells versus 
active cells appears above the pie chart

The table displays the data used to create the pie chart. This includes the library 
name, library type, the number of active cells, the number of free cells, the total 
number of cells, and the percentage utilized.

Clicking on an area in the pie chart displays the Library Asset View report. Clicking 
the Library Name link displays the Library Configuration View. Both reports are 
subsequently described in the Tape Libraries section of this manual.

Fabric Switch Utilization - This pane summarizes the utilization of your fabric 
switches. The pie chart displays the number of free ports and the number of used 
ports for the fabrics monitored by the Fabric Agent(s).  Clicking on the pie chart 
displays the Fabric Configuration report.

The table displays the data used to create the pie chart, including the fabric name, 
switch name, used ports, total ports, and percentage of total ports utilized for the 
fabric switches. By default, the Fabric Name is the WWN of the principal switch. 
However, the Fabric Name field may display the alias name of a principal switch. 
The Fabric Name link displays the Detailed Fabric View report; the Switch Name 
link displays the Detailed Switch View report.

TSM Summary Report - This pane allows you to quickly identify the status of TSM 
backup events. The pie chart summarizes backup events by successful, failed, and 
missed percentage over the past twenty-four hours for all the TSM servers in the 
site. 

The table displays the data used to create the pie chart. This includes the TSM server 
name, the aggregate number of successful events, missed events and failures.

NAS Filesystem Overview - This pane displays summary information on utilization 
of NAS file systems over the past twenty-four hours. The pie chart summarizes NAS 
file system utilization by storage used, available, used for snapshots, and total 
storage utilized (GB). The table contains the following fields:

■ Filesystem Name 

■ Capacity Used (GB)
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■ Capacity Available (GB)

■ Snapshot Used (GB)

■ Snapshot Reserved (GB)

■ Total Capacity (GB) [Capacity Used + Capacity Available + Snapshot]

■ %Utilized  [Capacity Used / Total Capacity]

The pane is sorted through the %Utilized column in descending order.

Clicking the pie chart displays the NAS Filesystem Overview that shows the NAS 
file system utilization in a tabular format. Clicking the Filesystem Name link in the 
pane displays the NAS Filesystem Details report for the selected NAS file system.

Dashboard Administration
A dashboard is a set of panes on the Sun StorageTek Business Analytics 
Management Console Home Page. Dashboard Administration allows the user to 
view existing dashboards, set their current dashboard, as well as add, modify, or 
remove dashboards.

Change Dashboard
Change Dashboard allows you to choose your customized Management Console 
home page. 

Note – After a current dashboard is selected, it persists between Management 
Console login sessions until that dashboard is changed. The Manage Dashboards 
menus allow you to create, modify, and delete dashboards that can be selected as the 
current dashboard (or customized Home Page).

Proceed as follows:

1. Log in to the Management Console.

2. Select Dashboard Administration → Change Dashboard from the Tools pull-down 
menu. 

The Change Dashboard Selection window appears.
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FIGURE 1-10 Change Dashboard Selection

3. Change Dashboard Selection contains a table with radio boxes under the Select 
heading allowing you to select a dashboard as well as the Dashboard Name, 
Dashboard Type (private or public), and Description fields. 

The window also contains the Set as Current Dashboard and Close buttons. Clicking 
Close will close this window.

4. To set the current dashboard, proceed as follows:

a. Use the radio box under the Select heading to choose the desired dashboard.

b. Click the Set as Current Dashboard button. 

The "Default Dashboard has been changed. Click the OK button to close this 
window and refresh the Home Page" dialog appears.

c. Click OK and the customized Home Page will appear.

Views
A view is a collection of assets and reports. Sun StorageTek Business Analytics 
report security is controlled by what view is assigned to the user. A Sun StorageTek 
Business Analytics report is what is generated when you select a menu item, such as 
Connection Exception or Capacity Allocation, in the Management Console 
application.

Users are assigned one or multiple views. Some general characteristics are described 
as follows:

■ There are two view types: Asset View and Composite View.
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■ An Asset View is assigned any number of monitored assets, such as servers, 
arrays, switches, NAS devices, NAS filesystems, databases, and tape libraries. 

■ An asset can be added to multiple views.

■ A site is also considered an asset, and it provides visualization of all the resources 
(arrays, fabrics, servers, etc.) collected by the Local Managers assigned to that site. 

■ A Composite View is comprised of one or more Asset views. 

In simple terms, report security is essentially controlled through your view.

After you successfully log in to the Management Console, you can access and view 
Sun StorageTek Business Analytics reports based on:

■ The installed Sun StorageTek Business Analytics products (storage, fabrics, 
backup, database) that the administrator has enabled

■ Your assigned views

The View tab appears at the top right section of the Home Page. By clicking the 
down arrow tab that is shown below, you can choose a current view from a 
displayed list of available views. The name of the current view appears to the left of 
the tab.

FIGURE 1-11 View Tab

Introducing Sun StorageTek Business 
Analytics Reports
The Management Console’s Home Page contains a set of pull-down menus that 
provide the primary means to view Sun StorageTek Business Analytics reports. 
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Assets
The Assets pull-down menu allows you to access and view the following reports:

■ Asset Management - Provides a high-level view of all your assets, including host 
servers, switches, tape libraries, and storage arrays by location and over a user-
defined period of time. 

■ Tabular Device Reports - View related information (e.g., file systems, databases, 
backup, storage allocation, billing, and more) for a selected asset (e.g., host).

■ Configuration Change - Details the changes in the configuration of a host, switch, 
array, NAS device, or tape library over a user-defined period of time.

■ Charting Wizards - Easily produce charts based on user-specified data extraction 
specifications.

Storage 
The Storage pull-down menu allows you to access and view the following reports:

■ Array Trending and Forecasting - Analyze historical consumption for an array, 
site, or the entire enterprise by using the Trending option. Use the Forecasting 
option when budgeting for storage purchases and to more accurately time 
purchases to match your needs.

■ Capacity Allocation - Determine how much storage each server in your 
organization is consuming summarized by view or site.  Use this report to assist 
in tasks like charge back billing and storage provisioning.

■ Storage Discrepancy Report - Identifies storage that appears to be allocated but, in 
reality, may not be usable.

■ Connection Exception - Identify possible configuration errors by viewing: (a) 
array front-end director ports without corresponding switch connections and (b) 
host adapter ports without corresponding switch connections. Use this report to 
assist in end-to-end configuration management.

■ Array Performance - View front-end controller, cache, and disk controller 
performance reports that can be used to identify performance bottlenecks and 
determine the most effective upgrade options for an array.

■ Allocation Forecast - Analyze storage allocation to host servers over a year 
summarized by site or view.

■ Storage Allocation - View the historical allocation of storage summarized by array 
vendor, or RAID type.

■ NAS Filesystem Utilization - Analyze filesystem utilization over the past four 
weeks summarized by enterprise, site, or server.
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■ NAS Filesystem Trending - View used capacity, available capacity, unassigned 
capacity, and capacity used for snapshots over the past four weeks summarized 
by enterprise, site, or server.

■ NAS Quotas - Determine how many Quotas are allocated per filesystem. It also 
allows determining the Hard/Soft Quotas per filesystem which can be sorted by 
user/group/directory.

■ Reporting Wizards - Access the Volume Configuration Wizard and the Array 
Configuration Wizard used to create ad-hoc storage-related reports. 

Tip – The amount of data returned by a wizard is limited by system resources.  For 
large data extracts, custom reports should be written against the database.

Fabrics 
The Fabrics pull-down menu allows you to access and view the following reports:

■ Fabric Trending and Forecasting - Determine how many switch ports have been 
consumed in your organization. Use the Trending option to analyze historical 
consumption for a file-system, server, site, or the entire enterprise. 

■ Use the Forecasting option allows to project future switch port requirements 
based upon past usage and planned projects. Use this report when budgeting for 
switch purchases, and to more accurately time purchases to match your needs

■ Fabric Performance - Analyze fabric switch performance on a port-by-port basis 
by viewing error and port or fabric busy statistics as well as average transmitted 
and received frames/bytes per second.

■ Storage Network Topology - The Storage Network Topology report provides a 
graphical view of the storage environment. It requires that the supported Java 
Runtime Environment (JRE) is installed on our computer.

■ Fabric Configuration - View a high-level fabric summary report as well as use the 
capability to obtain detailed reports on fabrics and connected hosts or storage 
arrays.

Backup/Restore 
The Backup/Restore pull-down menu allows you to access and view the following 
reports. Refer to Chapter 5 for specific information which reports are valid for the 
different backup applications.

■ Reporting Wizards - Provides access to the Job Report Wizard, Media Report 
Wizard, and Backup Success Wizard. The Job Report Wizard allows you to create 
custom reports using the Sun StorageTek Business Analytics backup job tables. 
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The Media Report Wizard allows you to reate custom reports using the media 
information stored in the Sun StorageTek Business Analytics database. The 
Backup Success Wizard allows you to create custom daily performance reports 
related to backup report metrics that you specify.

Tip – The amount of data returned by a wizard is limited by system resources.  For 
large data extracts, custom reports should be written against the database.

■ Backup Exceptions - Identify all hosts, file systems, and databases that are not 
part of an active backup job.

■ Backup/Restore Job Summary - View backup/restore job statuses summarized by 
the view, site, or backup server level.

■ Media Trending - Plan sufficient tape library media based on tape library 
utilization over a specified time interval.

■ Backup Schedules - View the types of backups scheduled for a seven-day period 
as of the current date.

■ Meta Database Capacity - Analyze the backup catalog disk utilization over a user-
defined time interval.

■ Real Time Events - Allows the backup administrator to quickly determine which 
backup jobs are failing. This report requires the Semantec Veritas SNMP 
Extension optional package.

■ Backup Exposure - Shows the hosts that are not associated with any Backup 
clients, and any Backup clients that are not associated with any Host agent.

■ TSM Daily Administration - For Tivoli Storage Manager, provides an expedient 
way to view the overall health of all TSM servers at a site.

■ TSM Event Summary - For Tivoli Storage Manager, view the Scheduled Event 
Completion Summary in a pie chart and tabular format that shows the percentage 
of events completed, failed, and missed over a specified time interval.

■ TSM Reporting Wizards - The TSM reporting wizards allow you to create 
customized reports TSM job/event status and success, occupancy, and media. 

■ Library Asset View - View utilization of your tape library resources summarized 
by site or individual library.

■ Global Status View - Verify the status of the library, drives, and CAP.

■ Library Statistics View - View the number of initializations, exchange rate, the 
percentage of target reads that were successful, and the number of retries for any 
tape library in your backup infrastructure.

■ Tape Drive Allocation - Show drive utilization within a user-specified number of 
hours.

■ Backup Media Search - Locate tape media by entering a tape label as a search 
string, entering a backup client as a search string, or by entering a backup server 
as a search string.
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Servers 
The Servers pull-down menu allows you to access and view the following reports:

■ HBA Configuration - View the vendor, model, WWN, IP address, node name and 
driver revision level of each Host Bus Adapter (HBA) or view this information 
summarized by site. 

■ OS Type - View the operating system of each server, and the percentage of 
operating system types by site. At the level of the individual server, determine the 
operating system name and release level, the IP address, the kernel patch level, 
and the node name.

■ Server Trending and Forecasting - Determine file-system utilization patterns for 
your organization summarized for sites.

■ Filesystem Utilization - Gain insight into the distribution of files and their relative 
sizes across the various file systems.

■ Filesystem Consumers - Identify the amount of storage capacity used by 
particular host Users/Groups.

■ Filesystem Age - Determine obsolete files, summarized by percent accessed, 
modified, or created, which are candidates for deletion on a selected host server.

■ File-Level Wizard - Use to interactively generate and save customized reports that 
include specific file names and paths.

■ Filesystem Wizard - Create custom reports using the host file system table.  

■ Server Wizard - Create custom reports using the host configuration tables.  

■ HBA Wizard - Create custom reports using the Host Bus Adapter (HBA) table.

■ Disks Wizard - Create custom reports using the host physical and logical storage 
configuration information in the host tables.

Tip – The amount of data returned by a wizard is limited by system resources.  For 
large data extracts, custom reports should be written against the database.

Databases
The Databases pull-down menu allows you to access and view the Database 
Capacity/Configuration report. This report provides details on the database servers, 
databases, and the databases utilization of physical storage resources 
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Provisioning
The Provisioning pull-down menu allows you to access:

■ Storage Provisioning Wizard - Locate available storage for allocation to a server.

■ Storage Reservations - Manage the storage provisioning reservations in the 
system.

■ Provisioning Summary Report - View all storage reserved for a selected host over 
a user-specified date range.

Sun StorageTek Business Analytics 
Report Items
FIGURE 1-12 identifies the items in a Sun StorageTek Business Analytics report screen.

FIGURE 1-12 Report Items

Sun StorageTek Business Analytics reports can be divided into several frames:
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■ Navigation Pane - Is the left frame that allows you to navigate through the 
reporting options, such as to display a view-level, site-level, or device-level 
report.

■ Report Pane - Displays the report data in the frame to the right of the navigation 
frame.

Tabular Device Reports
In some instances, the administrator may want to examine all the related 
information about a particular device, such as a host server, fabric switch, NAS 
server, or storage array. Under Asset Management, you can access the tabular device 
reports that are designed to address this requirement. 

Each tabular device report provides a default tab General that displays general 
information about the device. In addition, these reports provide a series of tabs to 
allow the administration to access report information about specific properties of the 
device (asset, configuration, performance, trending, etc.) as appropriate for the 
device family, The Detailed Array Configuration report (FIGURE 1-13) represents one 
of the tabular device reports Sun StorageTek Business Analytics provides.

FIGURE 1-13 Tabular Device Reports

The New Window button allows the administrator to display information from 
several device tabs (e.g., ports and performance for an array) in their own window. 
Asset information is defined using the User-Defined Fields menus under Database 
Administration selection from the Tools pull-down menu.

Report Wizards
The Management Console provides a wizard capability that addresses to some 
extent the need to customize reporting.  Using a simple table reporting capability, 
you can generate and save personal reports. Business Analytics delivers the Wizard 
functionality through a standard set of data-driven wizard templates. The templates 
point to database views that control the report columns you can choose for a report.
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Standard functionality includes the ability to:

■ Choose to run an existing report or use the Wizard capability to create a new one.

■ Select fields to be included in the custom report from a pre-defined list.

■ Enter conditions (or filters) that control what data records are extracted and 
displayed.

■ Determine the (sort) order in which records are displayed.

■ Define Summary Column and apply Summarized  functions that enable including 
subtotal/group results in a custom report.

■ Use the above capabilities to generate a report that can be printed, scheduled, 
exported, and/or saved for future use

Like the standard reports, the wizards also allow exporting data to standard formats 
(ASCII, Excel, .XML). 

Calendar 
Sun StorageTek Business Analytics enables generating reports like "display the 
number of successful backup jobs over the previous day". The Calendar icon 
provides an easy way you can select a specific start date and end date for the 
reporting interval. After you set the date range, you click Generate Report and a 
report appears for the time interval that you selected. 

Export Data
Sun StorageTek Business Analytics reports provide an Export button that provides 
you the option to transfer the data collected and used by Sun StorageTek Business 
Analytics, to other applications (e.g., Excel) in the user’s computing environment.

The exported data formats are listed as follows:

■ ASCII text

■ XML 

■ Excel tab-delimited

The Storage Network Topology diagram can be exported to an XML format that is 
compatible with Visio 2003 or higher. This functionality is explained in the 
subsequent section on the Storage Network Topology report.
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Report Scheduling
Sun StorageTek Business Analytics reports include a Schedule button to allow you to 
schedule a report. A scheduled report consists of a schedule for the distribution of 
an e-mail containing the report URL. If the fully qualified name 'Scheduler.FQDN = 
value' (e.g., Scheduler.FQDN  = GALILEO') in the "scheduler.properties file" contains 
a special character or space, the report link will not work properly. 

Note – For ad-hoc reports you generate using the reporting wizards, you must save 
the report before you can specify it to be scheduled using Report Scheduling.

Proceed as follows.

1. Click the Schedule button on a report and the Report Scheduling window 
appears. 

The name of the report appears in the non-modifiable Report Name field.
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FIGURE 1-14 Report Scheduling

The report fields are described as follows:

■ Report Name - Non-modifiable report name.

■ Current Server GMT Time - Current time in GMT on the Management Console 
server.

■ Start Time - Pull-down menus to set the start time (hh:mm) for the scheduled 
report. Select the time in GMT format; 24-hour time.

■ Report Parameters - Allows you to determine how any report date parameters 
behave when they are scheduled. You must set these parameters before you save 
the scheduled report. 
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FIGURE 1-15 Report Parameters

■ Start Date - Type the number of days prior to or subsequent to the report schedule 
to be observed for the scheduled report or use the "Fix date at" parameter, 
described below.

■ Fix date at - Put a check in the checkbox and use the Calendar icon to set a 
fixed date.

■ Recurs - Use this list box to set its recurrence as does not reoccur, reoccurs weekly, 
every two weeks, or monthly.

■ SMTP Server - Specify the IP address of the SMTP server.

■ SMTP Port - Specify the TCP Port Number for SMTP; the default port number is 
25.

■ GSM Email Addresses - Select the email address of a Sun StorageTek Business 
Analytics user and click >> to add that user to the report destinations.

■ Add More Contacts - Click to open a dialogue that allows you to enter the email 
address of an additional email recipient. 

2. Enter the SMTP email recipient and click OK.
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FIGURE 1-16 Add More Contacts

■ Report Memo - Type descriptive text concerning the scheduled report.

■ Add Contacts - Allows you to enter the email address of a recipient who is not a 
Sun StorageTek Business Analytics user.

3. To save the scheduled report, click Save on the Report Scheduling window. 

A confirmation dialogue is displayed.

FIGURE 1-17 Scheduled Report Confirmation

4. Click OK to confirm or Cancel to cancel.

5. If you click OK, the Report Scheduling Completed window is displayed.

6. Click Close.

Print
Sun StorageTek Business Analytics reports provide a Print button that allows you to 
print a displayed report on a local or network-attached printer.
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Closing Report Window
To close a report window, simply click on the X selection in the upper right hand 
corner of the report window or click the Close button, where applicable.

Logout
The Logout link allows you to close the present user session with the Management 
Console.  Clicking Logout will exit the Management Console, changing the browser 
to the Logout screen.

Click Login to return to the Management Console login screen.  Click Close Browser 
to close the browser session. 
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CHAPTER 2

Assets

This chapter describes the different reports available through the Management 
Console’s Assets pull down menu. The following topics are discussed:

■ “Asset Management” on page 27

■ “Asset Management - Tabular Device Reports” on page 29

■ “Asset Management -Detailed NAS Configuration” on page 34

■ “Asset Management - Detailed Library Configuration” on page 37

■ “Configuration Change Report” on page 39

■ “Charting Wizards” on page 43

Asset Management
The Asset Management report allows you to view both summary and detailed level 
information on your host servers, fabric switches, arrays, NAS devices, and tape 
libraries.

1. From the Management Console Home Page, select Assets.

2. Use the Calendar function to set the desired start date and end date for data 
extraction or accept the default range of the past four weeks.

3. For a selected site. 

You can expand it in the navigation pane to view the hosts, switches, arrays, NAS 
Devices, and tape libraries comprising its assets.

The following sections describe site-level information you can display in the right 
frame of the Asset Management report.
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Host Listing
Host Listing shows the host name, IP address, Operating System, version, release 
level, CPU manufacturer, CPU model, and number of CPUs for all host servers. Click 
the Hosts icon in the left frame to display this host information in the right frame.

Switch Listing
Switch Listing displays the Switch WWN, the associated Fabric WWN, the alias, and 
the vendor. Click the Switches icon in the left frame to display the switch 
information in the right frame.

Storage Array Listing
Storage Array Listing displays the Array ID, maker, name, model, cache, physical 
disk, and any optional, user-defined asset fields. Click the Array icon in the left 
frame to display the agent collected and user-defined array information in the right 
frame.

FIGURE 2-1 Storage Array Listing
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NAS Detail
NAS Detail displays the System Name, System ID, Product, Mode, and Maker fields.  

Click the NAS icon in the navigation pane to display the NAS detail information in 
the right frame. Clicking the System Name link displays the Detailed NAS 
Configuration report.

Tape Library Utilization
Tape Library Utilization displays the Library Name, Library Type, Active Cells, Free 
Cells, Total Cells, and Percent Utilized fields. Click the Tape Libraries icon in the 
navigation pane to display the high-level library utilization information in the right 
frame.

Asset Management - Tabular Device 
Reports
Asset Management provides access to the tabular device reports. Each tabular device 
report has a header frame that includes:

■ Site name 

■ Device name

■ Current report date

■ Calendar icon and Refresh button to refresh the report data

■ New Window button to initiate a second instance of the report window in a new 
browser and, thereby, allow to compare reports on different tabs

The following sections describe the tabular device reports you can access from the 
Asset Management report. If you select a tab and there is no data available in the 
database to produce the report, the report will display this status (e.g., "No 
Information Available").
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Detailed Host Configuration and Utilization
Clicking on a particular host server in the Asset Management navigation pane 
displays the Detailed Host Configuration and Utilization report. The top section 
identifies the server name, platform (e.g., Windows NT), IP address, and site for the 
host. 

FIGURE 2-2 Detailed Host Configuration and Utilization

The following table appears below this general information:

■ System -OS name/release level, vendor name (e.g., Intel), number of CPUs, kernel 
patch, and amount of memory.

■ Ethernet Interfaces -IP address, IP name, Media Access Layer (MAC) address, 
MAC name.

■ HBA Interfaces - HBA vendor, model, World Wide Node Name, World Wide Port 
Name, HBA driver revision, HBA firmware revision.

■ Physical Devices - Device name, capacity (GB), status, vendor, product, array and 
volume (if SAN attached).
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The tabular device reports are described as follows:

■ Filesystem - View aggregate filesystem utilization information that includes the 
number of filesystems, total size (MB), used space (MB), and percentage of space 
utilized. At the filesystem-level, the filesystem name, type (e.g., NTFS), total and 
used size, and percentage of space utilized are shown. Filesystem Name is a link 
to the Filesystem Details report if the SRM Agents have been installed. This page 
also links to the Volume Allocation report if the volume is provided over the 
SAN.

■ Shares - View the share name, type (e.g., CIFS), share path, filesystem name, and 
options.

■ Allocation - View the Volume Allocation summary report for the host.

■ Fabric - View HBA interface and switch port information showing how the host 
connects through the SAN to its storage.

■ Topology - Shows graphical depiction of the host’s connection(s) to the SAN, if 
SAN-connected.

■ Backup - Displays the Job Details report for this backup client, if applicable.

■ Databases - Displays the Database Server Details, Databases, Table Spaces/Device 
Details, and Filesystem Dependencies tables.

■ Database Server Details identifies the instance Name, type, version, port, and 
number of databases.  

■ Databases shows the instance name, database name, owner name, devices used 
for table spaces. It also provides counts for tables, indices, and users. The top 
five instances (by rows count) are also identified.

■ Table Spaces/Device Details identifies the instance name, table space device 
name, type (e.g., datafile), physical name (e.g., e:\Program Files\Microsoft 
SQL Server\MSSQL$ADVANCE2_CS†ata\model.mdf), percentage of space 
available, total space, and used space.

■ File System Dependencies - Identifies filesystem dependencies for the database 
instance by instance name, database name, filesystem name, filesystem 
maximum size (MB), and filesystem used size (MB).

■ Asset - Displays the Host Detail report with asset data for the host, if defined.

Detailed Switch Configuration
Clicking on a particular switch in the Asset Management navigation pane displays 
the Detailed Switch Configuration - Detailed Switch Report.  The General tab header 
identifies the Site, Switch Id, Switch Vendor, Switch Model, and the date of the last 
update.
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The Switch Detail table shows the Switch Name, Switch WWN, Fabric WWN, 
Vendor, Domain ID, Switch Model, Management IP Address, software version, 
status, total number of ports, number of ISL ports, number of offline ports, and the 
number of connected nodes. 

FIGURE 2-3 Detailed Switch Configuration - Detailed Switch Report

The additional tabular device reports are briefly described as follows:

■ Ports - Provides information about the ports in the switch and connections to 
other devices or switches as applicable. For each switch port, a table displays the 
Port Number, Port WWN, Status, Zone Alias, Attached Device Name, and 
Attached Device WWPN.

■ Zoning - Displays the Fabric Configuration report that provides information 
about the current zoning configuration including aliases, active configuration, 
and nodes attached to the fabric. The following reports can be accessed:

■ Clicking the Active Zone set icon displays the zone name and members of each 
zone in the active zone set.

■ Clicking the Defined Zone Sets icon displays the zone members and alias 
information. 
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■ Defined Zones allows you to select a zone and displays its fabric name, fabric 
WWN, its zone sets, and member list.

■ Defined Aliases enables you to view the Fabric Alias, Fabric WWN, Mgt. IP 
address, the number of aliases defined, and the alias name memberlist.

■ Member Switches - Provides a convenient link to the Detailed Switch View 
report for a selected switch.

■ Attached Nodes - Divides attached nodes into several categories: Arrays, 
Interswitch Links, and Others. Clicking on an Array/Interswitch Link/Other 
(device type) displays the Detailed Node Connection View report. Its Physical 
Connection Summary table identifies the Local Port, its WWNN/WWPN, the 
name of the fabric to which the local port is connected, its attached switch, the 
switch port, as well as alias and zone information. 

■ Performance - Displays the Fabric Performance report for the specified switch.

■ Asset - Displays user-defined asset information for the selected switch.

Detailed Array Configuration
Clicking on a particular array in the Asset Management navigation pane displays the 
Detailed Array Configuration report. The General window displays the Site, Array 
ID, and Date fields. Summary-level information includes the software version, Cache 
Size, number of Front End Controllers, number of Back End Controllers, and the 
number of Front End Ports.

The Physical Disks table shows the number of disks, the raw capacity (GB) per disk, 
the number of data/parity disks, and the number of hot spares. The Configured 
Volumes table provides information regarding the use of the logical volumes. 

You can select any of the tabs:

■ Ports - Displays information about the front-end ports in the array and their 
connections to switches, when applicable.  

■ Volume Configuration - Displays information about the configuration of volumes 
in the array. Choose one of the following filter options: Allocated Volumes, 
Unallocated Volumes as well as one of the following display options, Front-End 
Controllers, or Physical Disks, before you click Generate Report to generate the 
report. 

■ Volume Allocation - Before the report is generated, select one of the following 
report filters (radio buttons): Show All Volumes (default selection), Show Only 
Assigned Volumes, Show Only Unassigned Volumes, Show Only Unassigned, 
Mapped Volumes, Show Only Unmapped Volumes. Also select whether or not to 
display volume details (check box).  Finally, select one of the following display 
options (radio buttons): by Host, by Volume, or by Port before you click Generate 
Report to generate the report. 
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■ Performance - Provides a consolidated launch point to access any available 
performance report for the specific array. Select the report range (Start Date/End 
Date) and the type of performance report, Disk Controller I/O, Front End 
Controller, Daily Cache-Hits, or Hourly Cache-Hits before you click Generate 
Report to generate the report, as shown in Figure 16.

FIGURE 2-4 Detailed Array Configuration - Performance Report Filters

■ Trending - Provides a consolidated launch point to access any available trending 
reports for the specific array.

■ Asset - Displays user-defined asset information for the selected array.

Asset Management -Detailed NAS 
Configuration
Clicking on a particular NAS server displays the Detailed NAS Configuration report.
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FIGURE 2-5 Detailed NAS Configuration

■ The General tab displays NAS Configuration information and a summary of the 
NAS server options. The report window mainly consists of three tables: 

■ NAS Server Details

■ Storage Details

■ Option Details

The NAS Server Details table provides the following information:

■ Component ID

■ RAM

■ NVRAM

■ Software Version

■ Firmware Version

■ Number of CPUs

■ Cluster Partner

■ Cluster Status  
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■ Cluster Partner Status   

The Storage Details table contains the following information: 

■ Usable Volumes  

■ Usable Size (GB)

■ Allocated Size (GB)

■ Unallocated Size (GB)

■ Configured Raw Size (GB)

■ Raw Disk Size (GB)

■ Number of Physical Disks

■ Hot spare Size (GB)

■ Number of Hot spare Disks   

The Option Details table should contains two sections showing the following details:

■ Licensing

■ Option Name

■ Option Value

■ Configuration

■ Option Name

■ Option Value

You can select any of the following tabs:

■ Components - Displays data for any components added to the NAS server. If the 
server is a Network Appliance filer, there are no additional component details to 
display. If the server is a Celerra File Server, components of type ’Data Mover’ are 
displayed on this tab. In addition, this report displays the Component ID, name, 
type, speed (Mb/sec), IP Address, and operational status of both host facing and 
storage facing interfaces. If the interface type is "softwareloopback(24)", the 
information is not displayed in the Host facing table.

■ Filesystem - Provides summary-level information on all filesystems on the server 
as well as detailed information on each file system. The summary-level details 
include the number of file systems, total capacity, capacity used (GB), capacity 
available (GB), snapshot used (GB), snapshot reserved (GB), total snapshot (GB), 
and % utilized. The filesystem details table shows the filesystem name, type (e.g. 
wafl), total capacity, capacity used (GB), capacity available (GB), snapshot used 
(GB), snapshot reserved (GB), and total snapshot for each filesystem on the server. 

Clicking the Logical Volume Configuration link displays the NAS Logical Volume 
Report window. Reports are available at the logical volume, file system, and 
physical disk levels for the specified NAS server (e.g., netapp01). By using the 
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scroll bars, you can quickly determine how storage capacity is allocated for file 
systems accessed by clients and snapshots that facilitate backups. This 
information is provided from a logical volume and physical disk perspective.

■ Share Configuration - Allows you to view the NAS Share Configuration report. It 
identifies the Share Name, Share Type, Share Path, Filesystem Name, and 
Options. The path and access options details can be useful when troubleshooting 
why a network client cannot mount a file system.

■ Quotas - Allows you to generate the NAS Report: Quotas Details report sorted by 
user, group, or directory. The window that allows you to set the filter and display 
be options contains a table of definitions (e.g., Hard Quota) and options (e.g., sort 
by directory) to help you choose your desired settings. 

The NAS Report: Quotas Details report contains a table for each filesystem that 
identifies the Quota ID, Quota Target (e.g., user), Tree (qtree name), Quota 
Specifier, Quota Used(GB),  Hard Limit(GB),  % Hard Utilized. The heading above 
each table shows the File system ID, Total Capacity (GB), and Capacity Available 
(GB).    

■ Asset - Displays user-defined asset information for the selected NAS device.

Asset Management - Detailed Library 
Configuration 
Clicking on a particular library device in the Asset Management navigation pane 
displays the Detailed Library Configuration report for that tape library. The report 
identifies the selected library by displaying the Site, Library Name, and Library 
Vendor/Model details.  It also shows the high-level utilization of the library by 
displaying the number of free cells, active cells, and total cells in both a pie chart and 
table.
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FIGURE 2-6 Detailed Library Configuration

■ You can select any of the tabs:

■ Cells - Shows the cells in the library and what tapes are located in individual 
cells.

■ Drives - Displays Drive ID, vendor, model, as well as summarized time allocated, 
time free, time offline, time degraded, and time unknown for that drive.

■ Media - Shows media details that include volume id, bar code, media type (and 
correlates it with any information available via the Sun StorageTek Business 
Analytics backup agents).

■ Assets- Displays user-defined asset information, if applicable.

■ Status - Provides general health information on the library and serves as the entry 
point to view event information related to any failures.

■ Statistics - Displays statistics that include the number of initializations, exchange 
rate per hour and total number, the percentage of target reads that were 
successful, and the number of retries. Note: This report is blank if the tape library 
is monitored by the ACSLS Agent.

■ Drive Allocation - Displays the drive status summary (allocated, free, degraded, 
unknown, and offline) by hour over the past 24-hours.
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Configuration Change Report
The Configuration Change report displays any configuration changes that have 
occurred for an asset over a specified time interval. Host servers, NAS devices, and 
Tape Libraries comprise the assets. Since the administrator typically examines what 
has changed since a device stopped working properly, this report can serve as the 
first step in troubleshooting many routine problems.

In the Configuration Change report, data is shown in the range of the user specified 
dates, as it is done in other Sun StorageTek Business Analytics reports. The default 
start and end date range is the past seven days. The changes are grouped by 
date/time and are presented in reverse historical order (most recent changes first).

Array
The Array report displays the following types of configuration changes:

■ Software version

■ Cache Size

■ Controllers

■ Front-end Controllers

■ Back-end Controllers

■ Front-end Ports

■ Physical Disks

■ Hot Spares

Host
The Host report displays the following types of configuration changes:

■ IP Address

■ Kernel Patch

■ OS Name/Release Level

■ Memory

■ CPUs

■ Filesystem count
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Switch
The Switches report displays the following types of configuration changes:

■ Switch Name

■ Switch WWN

■ Domain ID

■ Management IP

■ Firmware

The Switches report contains the "Analyze Port Configuration" link.  Clicking this 
link opens a separate report that shows ports with changes in:

■ Port WWN

■ Zone Alias

■ Attached Device Name

■ Attached WWN

NAS 
The NAS report shows the following types of configuration changes:

■ RAM

■ NVRAM

■ Software Version

■ Firmware Version

■ Cluster Status

■ Cluster Partner

■ Usable Volumes

■ Number of Physical Disks

■ Number of Hot Spare Disks

■ Number of logical volumes

■ Filesystem count

Library
The Library report shows the following types of configuration changes:

■ Library Name
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■ Firmware Version

■ Number of Drives

■ Number of Pass-Thru Ports

■ CAP Cells

The Libraries report includes the "Analyze Drive Configuration" link.  Clicking this 
link displays a separate report that shows drives with changes in:

■ Model

■ Vendor

■ Serial Number

■ Firmware Revision

■ WWPN

■ Interface Address

Proceed as follows:

1. From the Management Console Home Page, select Assets.

2. Select Configuration Change and the Configuration Change Report main window 
appears.

3. Enter a start and end date in the Control Pane located in the upper left section of 
the report.

4. Use the navigation pane on the left to navigate to and select an asset. 

The tables on the right will detail the changes in that asset’s configuration. The top 
table describes the "Changed" details for the asset over the specified start and end 
date range. The bottom table identifies the "Not Changed" configuration attributes 
during the specified start and end date range.

If no configuration changes have occurred for the selected device over that time 
range, the "No configuration change details found within selected dates. Please 
select different range." message is displayed. 
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FIGURE 2-7 Sample Configuration Change Report - Switch

The following sample Configuration Change Report shows that the host server’s IP 
address changed during the date range specified, but all other configuration data 
did not change.
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FIGURE 2-8 Sample Configuration Change Report - Host

Charting Wizards
The Charting Wizards help you to create customized charts based on data stored in 
the Sun StorageTek Business Analytics database. The following chart types are 
supported:

■ Bar Chart

■ Pie Chart

■ Line Chart

Charting Wizards allows you to create and save new charts, edit existing charts, or 
generate a saved chart. A limited number of chart types can be generated. You can 
select one "metric" or Y-axis for each chart. The Host Statistics Agent must be 
installed, running, and collecting performance statistics on a Solaris or AIX server to 
use the Host Performance Chart Wizard. 

The reports are based only on data in your current view.
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Create Chart Using Charting Wizard
1. Select Assets → Charting Wizards. 

The Select a Charting Wizard window is displayed, similar to the one shown in the 
following figure. It contains a table listing the available charting wizards and their 
selection box. If existing charts have been saved to the database, they are indented in 
the listing and are associated with an Edit and Display link. 

FIGURE 2-9 Select a Charting Wizard

2. Click on the selection box to choose the desired charting wizard and click Next>>. 

This example shows how to create a pie chart using the Host Filesystem Charting 
Wizard. With the exception of different data sets, all charting wizards are utilized 
similar to this example.

3. The Select Statistics for <charting wizard> window is displayed. You can choose 
one statistic per chart.

Choose the type of statistics you want to use for the chart. As displayed, the selected 
field will be used for pie chart division or will act as Y-Axis scale for line and 
column charts. This example uses Total Capacity (MB). 
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FIGURE 2-10 Select Statistics (Host Filesystem Chart Wizard)

4. Click Next>> and the Select Report columns for <charting wizard> window is 
displayed. 

Choose the columns you want to use for the chart in the Columns Available table 
and click Add> or click Add All>> to add all the columns to the chart.
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FIGURE 2-11 Select Report Columns (Host Filesystem Chart Wizard)

5. Click Next>> and the Select Report Filters for <charting wizard> window is 
displayed. 

Use the list boxes, such as field and arithmetic operator, as well as the input boxes 
(e.g., value) to set the selection criteria for the SQL query that will be used to extract 
the data for the chart. Without specifying any selection criteria, your chart may not 
be as legible and useful as you need.
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FIGURE 2-12 Select Report Filters (Host Filesystem Chart Wizard)

The Select Field variables depend on the charting wizard. The Operator drop-down 
list box contains a list of operators that are valid for the chosen field.  The 
relationship between the fields and the operators is described in the table below.

6. Click Next>> and the Select Type of Chart <chart wizard name> window appears. 
Enter the title of the chart in the Chart Title input box. 

Use the radio button to select a chart type: line chart, column chart, or pie chart. A 
graphical depiction of each chart type appears beside its radio selection box.

Optionally, set the Max. Chart Legend Count: parameter to a desired value and, 
thereby, restricting the number of legends that will appear in the report. This can 
enhance the readability of the report.

TABLE 2-1 Data Types and Valid Operators

Data Type Valid Operators

Numeric =, <>, >, >=, <, <=, IN

Date =, <>, >, >=, <, <=, IN

String Equal To, Like, In

List IN

Boolean =, <>, IN
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FIGURE 2-13 Select Chart Type

7. Click Next>> and the chart is generated and displayed. 

Beneath the chart, the data set used to create it appears in tabular format. 
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FIGURE 2-14 Sample Chart: Using Charting Wizards

8. Optionally type a chart name and click Save to save the chart into the database. 

You can then use the Edit or Display link on the Select a Charting Wizard window to 
modify or view the chart, respectively.

View/Edit Chart Using Charting Wizard
1. Select Assets → Charting Wizards. The Select a Charting Wizard window is 

displayed. 

2. Select the desired action:

a. Edit - Click the Edit link next to the chart name. 

The Select Statistics window appears. After you optionally change the statistics 
selection, use the Next>> button to cycle through all the windows used to change 
columns (fields) and report selection criteria.

b. Display - Click the Display link to view the chart.
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CHAPTER 3

Storage

This chapter describes the different reports available through the Management 
Console’s Storage pull down menu. The following topics are discussed:

■ “Array Trending and Forecasting” on page 51

■ “Capacity Allocation” on page 53

■ “Connection Exception” on page 61

■ “Array Performance” on page 62

■ “Allocation Forecast” on page 63

■ “Storage Allocation” on page 64

■ “NAS Filesystem Utilization” on page 67

■ “NAS Filesystem Trending” on page 69

■ “NAS Quota Details” on page 72

■ “Reporting Wizards (Storage)” on page 74

Array Trending and Forecasting
The Array Trending and Forecasting report allows you to determine how much 
storage is being consumed on each array in your organization. For a specified date 
range, you can see the Total GB, Used GB, Free GB, and percent utilized. The report 
is available at the view, site, and array levels. 

You can set the following options: 

■ Trending - The Trending option allows you to analyze historical consumption for 
an array, site, or the entire enterprise. This option only looks at past consumption. 
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■ Raw vs. Usable Storage - Selecting Raw calculates consumption based on the total 
storage consumed on the array, including RAID and other protection overhead. 
Selecting Usable calculates consumption based on the Usable space presented to 
the servers. 

■ Forecasting - The Forecasting option allows you to project future storage 
requirements based upon past usage and planned projects. Use this report when 
budgeting for storage purchases, and to more accurately time purchases to match 
your needs. 

■ Raw vs. Usable Storage - Selecting Raw calculates consumption based on the total 
storage consumed on the array, including RAID and other protection overhead. 
Selecting Usable calculates consumption based on the Usable space presented to 
the servers.

■ Forecast Period - Enter how far into the future you would like the report to 
forecast.

■ Targeted Maximum Consumption - If you wish to maintain a reserve of storage, 
indicate the amount as a percentage of your total. In other words, if you wish to 
manage your storage to 90% maximum usage (and maintain a 10% reserve), enter 
90% into this field. The report will indicate the date when you can anticipate 
consuming your targeted amount of storage based on historical usage. 

1. From the Management Console Home Page, select Storage.

2. Select Array Trending and Forecasting and the Array Trending and Forecasting 
report main window appears.

3. In the upper left section of the report, use the radio button to specify whether to 
generate a trending report only or to generate a trending and forecasting report.

4. Specify a forecasting period (if applicable) of 3 months, 6 months, 1 year, or 3 
years.

5. Specify the targeted consumption.

6. Enter a start and end date.

7. Click on an Enterprise View in the navigation pane to generate the Storage 
Trending: Enterprise Report, a Site to generate a site-level report, or expand a Site 
and click on a desired array to generate an array-specific report. 

The report shows the storage consumption using a line chart and tabular data. For a 
forecasting report, the date on which the user-selected maximum consumption will 
be reached is displayed. The table identifies the Date, Total GB, Used GB, Free GB, 
and percentage utilized. A sample Storage Forecasting: Array Report is shown 
below.
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FIGURE 3-1 Storage Forecasting: Array Report

Capacity Allocation
The Capacity Allocation report allows you to determine how much storage is being 
consumed by each server in your organization

You can set the following options before you generate the report: 

■ Show only those volumes allocated directly to the server - This option reports 
only volumes that are allocated from the array directly to the server. This 
primarily includes standard data volumes that are visible to that server. 

■ Show all associated volumes - This option reports the volumes above, plus the 
local and remote mirror copies associated with each standard volume assigned to 
the server. For example, if a data volume has a BCV that is allocated to the backup 
server; this option will report that storage as being consumed by the application 
server that owns the standard volume. This is useful when determining the "true" 
owner of the volume for charge-back purposes. 
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■ Report Usable Storage - Reports the amount of storage visible to the server, 
ignoring RAID or other data protection overhead. 

■ Report Raw Storage: Reports the amount of raw storage required on the array to 
provide the volumes to the server. This includes RAID or other data protection 
overhead. 

■ Report Shared Volumes for All Servers - By default, volumes that are allocated to 
more than one server (e.g. a cluster) will only be reported for one server. This 
prevents shared volumes from being counted multiple times. Selecting this option 
will report that volume to every server that can access it. 

Note – This may cause the total amount of storage allocated to exceed the amount 
of storage that exists.

When you generate a report, you can click on any header to set the report sort order.

1. From the Management Console Home Page, select Storage.

2. Select Capacity Allocation and the Capacity Allocation report main window 
appears.

3. In the Control Pane located in the upper left section of the report, use the radio 
button to specify whether to sort by Site or by Server.

4. Use the radio button to specify whether to report volumes allocated directly to the 
server or also report associated volumes (including local and remote copies).

5. Beside the "Report Shared Volumes for All Servers" heading, click the checkbox to 
put a check mark (enable) or remove the check mark (disable) for this report 
option.

6. Beside the "Report On:" heading, use the pull-down list box to report on usable 
storage or raw storage.

7. Click on a site in the menu control tree to generate a site-level report, or expand a 
site and click on a desired host server to generate a host-specific, storage 
allocation report.

At the view level, this report displays the site name, view name, host name, total 
number of volumes allocated to the host, total amount of allocated storage (GB), 
number of local copies and amount of storage (GB), number of standard volumes 
and amount of storage (GB), number of local copies and amount of storage (GB), 
number of remote copies and amount of storage (GB). Be aware that not all Sun 
StorageTek Business Analytics Array Agents populates tables with information on 
local and/or remote copies.



Chapter 3 Storage 55

FIGURE 3-2 Capacity Allocation by Site - View Level

At the site or server level, the report displays the Hostname, Total Volumes, Total 
GB, Standard Volumes, Standard GB, number of Local Copies, Local Copies (GB), 
number of Remote Copies, and Remote Copies (GB). 

Clicking on the Total Volumes link displays the Array ID, Volume ID, Raw Size 
(MB), and Usable Size (MB) associated with each allocated volume. 

Storage Discrepancy Report
The Storage Discrepancy Report menu selection provides access to the Storage 
Discrepancy Report and the Storage Discrepancy Details Report. 

Using Storage Discrepancy Report

Proceed as follows:

1. Select Storage Discrepancy Report from the Storage pull-down menu. 

The Storage Discrepancy Report appears. The report displays all storage 
discrepancies for all hosts present at the site and enterprise level. 
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2. When the report is first opened, no data is displayed. 

The following descriptive text appears in the report pane: 

The Control Pane section displays a single Date control (no date ranges) with the 
Application Date (by default) and a Refresh button.  It also provides an integer input 
box, labeled "Show discrepancies greater than <<input box>> GB". The default value 
in this box is 1. This can be used to account for rounding differences (e.g.,  storage 
volumes are reported in MBs while the Host Agent reports sizes in blocks).  

The Navigation Pane of the report displays the enterprise and sites hierarchy 
determined by the current view.

FIGURE 3-3 Storage Discrepancy Report

3. Select a site or entire enterprise view in the navigation pane to generate the 
report. 

A sample report for a selected site is shown in FIGURE 3-4.

The Storage Discrepancy Report identifies storage that appears to be allocated but 
in reality may not be usable.  This storage can typically be reclaimed for other uses.
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FIGURE 3-4 Storage Discrepancy Report - Site Level

4. The Storage Discrepancy Report contains the following sections:

■ The Storage Discrepancies table contains the following fields:

Note – Storage discrepancies occur when storage is allocated (masked) to a 
particular server in the array’s volume security database, but the server cannot see 
the storage due to a configuration problem.  For example, the volume may be 
mapped to a port that is not in any of the servers’ zones.

■ Host Name - The host name of the server. Clicking the Host Name link 
displays the Detailed Host Configuration and Utilization report for the selected 
host server.

■ Allocated Capacity (GB) - The total of all volumes allocated to the server. This 
reflects all the arrays in the view that have allocated storage to the host.
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■ Physical Capacity (GB) - The total of all allocated remote devices. These are 
also displayed when the Detailed Host Configuration and Utilization’s General 
tab is displayed for the particular host server.

■ Storage Discrepancy - The difference of Allocated Capacity - Physical Capacity.  

The Storage Discrepancy Report provides the following tool tips for the column 
names:

■ Allocated Capacity - Total amount of storage allocated from all arrays.

■ Physical Capacity - Amount of array storage visible on server.

■ Storage Discrepancy - Amount of allocated capacity not visible on server.

■ The Orphaned Storage table contains the following fields:

Note – Orphaned storage occurs when storage is masked to a WWN or alias which 
does not exist in the environment.  

■ Alias from Array - The alias name (which may be a text string or a WWN) from 
the LUN Security database on the array.

■ WWN - The WWN listed in the LUN Security database.

■ Volume - the Volume ID.

■ Capacity - The usable size of the volume from the array.

■ Allocated to Other WWNs - This check box contains a check if other allocation 
records exist for the volume. Otherwise, no check appears. 

Be aware that volumes which are allocated to other WWNs may have 
invalid/outdated allocation records which should be removed.  If the storage 
is not allocated to any other WWN, then it is either truly orphaned and can be 
reclaimed, or the WWN is outside of Sun StorageTek Business Analytics 
management.

The Storage Discrepancy Report provides the following tool tips for the column 
names:

■ Alias from Array - Alias name defined in array security database.

■ WWN - WWN the volume is masked to.

■ Volume - Volume ID on the array.

■ Capacity - Usable size of the volume.

■ Allocated to Other WWNs - Indicates whether the volume is also allocated to 
additional hosts.

■ The "Show discrepancies?" check box allows you to account for minor differences 
in the way that arrays and servers report volume sizes (e.g., bytes vs. blocks).  
You can also use this value to limit your search to large discrepancies.
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Storage Discrepancy Details Report

The Storage Discrepancy Details report uses the End-to-End Mapping information to 
separate the volumes that have been allocated to this server into two groups: 

■ Volumes that can be correlated to a physical device on the server (Volumes in 
Use)

■ Volumes that cannot be correlated to a physical device on the server 
(Discrepancies).

Caution – The ability to differentiate between local and networked devices on the 
host requires a Host Agent that supports End-to-End Mapping (see the latest Sun 
StorageTek Business Analytics Support Matrix for details).  For this reason, hosts 
that lack this support (including those running 3.x Host Agents) are suppressed 
from this report.

The report is displayed by clicking the Storage Discrepancy Details hyperlink in the 
Storage Discrepancy Report.

The Discrepancies section contains the following text to recommend steps to address 
discrepancies:

"The following volumes which have been allocated to this server do not appear to 
be visible to that server.  Verify the following for each volume:

■ The host’s HBA port and the array front-end port to which the volume is mapped 
are in the same fabric

■ The host’s HBA port and the array front-end port to which the volume is mapped 
are in the same zone

■ The zone which contains the host’s HBA and the array front-end port to which 
the volume is mapped is part of the Active Zone Set

■ For Solaris hosts, verify that the sd.conf file specifies an adequate range of 
Volume IDs to accommodate all volumes.

■ Check the HBA documentation to determine whether a reboot or utility is 
required to force the HBA to scan for new volumes (e.g., ioscan on some HP-UX 
servers).

■ For Windows hosts, run Disk Manager to ensure that it has placed a valid 
signature on the device and recognizes it."
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FIGURE 3-5 Storage Discrepancy Details

This text is followed by a table with the following columns:

■ Array ID - The array ID of the array that is providing this volume to the server.  
This is the array alias if one exists or the array id number if no alias exists. 
Clicking the Array ID link displays the Array Configuration Report for that array.

■ Volume - The volume ID of the volume on the array. Clicking the Volume ID link 
displays the Volume Details report for that volume.

■ Type - The volume type, as displayed on the Volume Configuration tab of the 
array reports (e.g., Admin (GK), Volume, BCV, etc.).

■ Size - The size, in Usable GB, of the volume

■ Mapped Alias(es) - The alias(es) to which the volume has been masked in the 
array’s volume security database.  This may consist of a text string or a WWN.  

■ Front-End Port(s) - The array front-end port(s) that the volume has been mapped 
to.  If the volume has not been mapped to a port, display "Unmapped". Clicking 
the Front End Port link displays the Array Configuration report for that volume.

The Volumes in Use section consists of a table with the following columns:
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■ Host Device Name - The name of the physical device as seen by the server.  On a 
Solaris host, this will use c#d#t# terminology (e.g., c2d1t0).  On a Windows host, 
this may appear as Harddisk1 or use other terminology. 

■ Capacity - The capacity in GB of the physical device as seen by the server.

■ Vendor - The vendor of the device as reported by the server.  This will typically 
reflect the array manufacturer.

■ Product - The product name of the device as reported by the server.  This will 
typically reflect the array type (e.g., Symmetrix).

■ Array ID - The array ID of the array that is providing this volume to the server.  
This is the array alias if one exists, or the array id number if no alias exists.

■ Volume - The volume ID of the volume on the array.

Connection Exception
This report provides two levels of detail on how storage resources are being utilized, 
showing ports not attached to any fabric switch in the SAN. This report can help the 
administrator to quickly identify possible configuration errors.

The default reporting date is the current date, but it can be reset using the Calendar 
function in conjunction with the Refresh Report button at the top section of the 
report.
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FIGURE 3-6 Connection Exception

The top portion of the report shows array front end controller ports without a 
connection to a switch. The report fields include the Site, Array ID, Alias, Front End 
Controller ID, Port WWN, Array Vendor, and Array Name and Model.

The lower portion shows Host Bus Adapters in host servers without switch 
connections. The report fields show the Site, Host, IP Address, Port WWN, HBA 
Vendor, and HBA Version and Model.

Array Performance
Array Performance provides access to the following different views of array 
performance:

■ Hourly Cache Performance report - Shows total cache hits and misses, plus a 
graph of total cache I/O per second. 

■ Front-End Controller I/O report - Shows the average I/O per second for a given 
array. Note that performance is shown per controller, not per port on the 
controller. 
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■ Disk Controller I/O report - Shows the average back-end controller I/O per 
second for a given array. 

These reports can be used to identify performance bottlenecks and determine the 
most effective upgrade options for an array. Be aware that some Array Agents do 
not collect performance data; contact your Sun representative for additional details. 

1. From the Management Console Home Page, select Storage.

2. Select Array Performance and the Array Performance: Front End Controller IO 
report main window appears by default.

3. In the upper left section of the report, use the radio button to specify the desired 
array performance view.

4. Set the start and end dates for the report.

The reports for the different performance views are described as follows:

■ Front End Controller IO - The view is available only for an array. The header 
identifies the Enterprise (view), the site, the array ID, and the report date/time 
interval. The chart depicts the average I/O rate by time of day where 
performance is shown per controller, not per port on the controller. Using the 
"Show by Week", "Use a fixed-scale Y axis with min. and max.", and Refresh Chart 
options, you can modify the chart’s appearance.

The table shows the performance data by Front End Port Address, Hour of Day, 
and Average IO. You can click on any header in the table to re-specify the sort 
order.  

■ Disk Controller IO - The view is available for a site or an array.

■ Hourly Cache IO - The view is available only for an array. The header identifies 
the Enterprise (view), the site, the array ID, and the report date/time interval. The 
graph provides a consolidated view of average hits and misses (in percentage) 
over the selected period. The table shows the performance data by Collection 
Time, Average Cache Hits, and Average Cache Misses.

Allocation Forecast
The Allocation Forecast report enables the administrator to:

■ View the previous year end storage allocation

■ View how storage was allocated for the year-to-date

■ View the forecasted storage capacity rate and allocation (GB)



64 Sun StorageTek Business Analytics Management Console User’s Guide • June 2006

The report is available at the enterprise view and site levels. It only displays data for 
a site or sites that are assigned to a view.

1. From the Management Console Home Page, select Storage.

2. Select Allocation Forecast and the Allocation Forecast main window is displayed.

3. In the control pane located in the upper left section of the report, use the list 
boxes to select the month and year to start extracting records for the report.

4. Click the enterprise view to generate the report at this level, or expand the menu 
control tree and click a desired site to generate the report at the site level.

The report provides the following information:

■ Server name

■ Previous year end allocation (based on selected start date)

■ Growth rate percentage for year-to-date

■ Expected year end storage allocation (GB)

■ Forecasted growth rate 

■ Forecasted storage allocation (GB)

■ Monthly breakdown of allocated storage over the reporting period

The Reporting Administration->Maintain Allocation Forecasting Report menu under 
Tools allows the administrator to populate the tables used for allocation forecasting

Storage Allocation
Storage Allocation shows the increase or decrease in storage allocated to host servers 
filtered by:

■ Storage Vendor

■ RAID Configuration

Trending by Vendor
1. Select Storage → Storage Allocation → Trending by Vendor from the home page. 

The Storage Allocation by Vendor parameters box appears.
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FIGURE 3-7 Storage Allocation Trending by Vendor

2. Use the radio button to specify reporting allocation by usable allocated capacity or 
by raw allocated capacity.

3. Use the Calendar function to specify the start date and end date for data 
extraction.

4. Use the Interval list box the interval: daily, weekly, monthly, annual, daily, or two 
dates.

5. Specify the chart type: Area chart or Histogram.

6. Click Generate Report. 
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FIGURE 3-8 Storage Capacity Allocation by Vendor

The report displays the data using the specified chart type. Beneath the chart, the 
data that was used to produce the chart appears in a table. To display charts in 3D as 
well as 2D graph modes, the Anonymous permission setting under Directory 
Security in the Internet Manager Services panel must be turned off.

Trending by RAID Configuration
7. Select Storage → Storage Allocation → Trending by RAID Configuration from the 

home page. 

The Storage Allocation by RAID Configuration parameters box appears.

8. Use the radio button to specify reporting allocation by usable allocated capacity or 
by raw allocated capacity.

9. Use the Calendar function to specify the start date and end date for data 
extraction.

10. Use the Interval list box the interval: daily, weekly, monthly, annual, daily, or two 
dates.

11. Specify the chart type: Area chart or Histogram.

12. Click Generate Report. 
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NAS Filesystem Utilization
The NAS Filesystem Utilization summary report shows the filesystem usage for the 
specified reporting date (default is current date) in graphical and tabular report 
formats. The information consists of "Shared" and "Not Shared" capacity based on 
total capacity (GB), used capacity, available capacity, and capacity used for 
snapshots. A snapshot is a point-in-time copy of a production file system that is 
typically used for backups.

The report is organized at the enterprise view, site, and server levels. It shows the 
following information:

■ Total Capacity (GB) 

■ Capacity Used (GB)

■ Capacity Available (GB) 

■ Snapshot Used (GB) 

■ Snapshot Reserved 

■ Total Snapshot (GB) 

The file system details are grouped on Shared and Not Shared type separately, and 
include the following details

■ Total Capacity (GB) 

■ Capacity Used (GB)

■ Capacity Available (GB) 

■ Snapshot Used (GB) 

■ Snapshot Reserved 

■ Total Snapshot (GB) 

Both the Shared and Not Shared File system types have individual totals. A sample 
filesystem utilization report at the site level follows.
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FIGURE 3-9 NAS Filesystem utilization - Site

At the NAS server level, the file system details table shows the file system name for 
each reported file system.



Chapter 3 Storage 69

FIGURE 3-10 NAS Server Filesystem Details

NAS Filesystem Trending
The NAS Filesystem Trending report shows the increase or decrease in capacity 
usage, beginning at the date of the report and going back four weeks. The filesystem 
trending information is displayed in both bar graph and tabular format. 

This report is available at the enterprise, site, and NAS server levels. The file system 
details are grouped on Shared and Not Shared type separately, and include the 
following details

■ Capacity Used (GB)

■ Capacity Available (GB) 

■ Total Snapshot (GB)

■ Total Capacity (GB)
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FIGURE 3-11 4 Week Enterprise-Level Overview: Enterprise

At the site level, you can obtain filesystem trending information both in bar graph 
and tabular format for all NAS servers at that particular site. In addition, you can 
obtain this information for a specified NAS server (device), as shown below.
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FIGURE 3-12 NAS Filesystem Trending - Server Level

The server-level report also provides storage allocation for each filesystem on the 
NAS server. Sample filesystem reports for two filesystems on a Network Appliance 
filer is shown below.



72 Sun StorageTek Business Analytics Management Console User’s Guide • June 2006

FIGURE 3-13 4 Week Filesystem Trending

NAS Quota Details 
Selecting NAS Quotas on the Storage pull down menu allows you to generate the 
NAS Quota Details report. The NAS Quota Details report allows you to determine 
how many Quotas are allocated per filesystem. It also allows to determine the 
Hard/Soft Quotas per filesystem which can be sorted by user/group/directory. 
Currently, NAS quota reporting is supported for file systems on Network Appliance 
filers only. 

When you select NAS Quotas, the NAS Quota Details report pane briefly describes 
the purpose of the report and its parameters.
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FIGURE 3-14 NAS Quota Details

The control pane allows you to:

■ Use the check boxes to set the desired sort order (i.e., by user, group, and/or 
directory).

■ Set report filter to all quotas, hard quotas, or soft quotas.

■ Set the start date for the data extraction. 

The navigation pane shows you sites and NAS devices as allowed by your current 
view. Click the plus sign beside a desired NetApp filer to view its file systems, Click 
on the icon in the navigation pane of the file system to display the NAS Quota 
Details report in the report pane. 

When you generate a report, a column chart is displayed in the top portion of the 
report pane. The chart shows quota utilization for the quota targets. Quota targets 
can be users, groups or qtrees. User and group quotas are applied on a per-volume 
or per-qtree basis. A qtree is a logically defined file system that can exist as a special 
subdirectory of the root directory within either a traditional volume or a flexible 
volume.  For NetApp devices, you can have a maximum of 4,995 qtrees on any 
volume.
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Beneath the column chart, the quota utilization details for the file system are 
displayed in a table. The table heading shows the File system ID, the Total Capacity 
(GB), and the     Capacity Available (GB) for that file system. For each quota, the 
table provides the following information:

■ Quota ID

■ Quota Target

■ Tree (qtree name)

■ Quota Specifier

■ Quota Used(GB)

■ Soft Limit(GB)

■ % Soft Utilized

■ Hard Limit(GB)

■ % Hard Utilized  

Reporting Wizards (Storage)
The Reporting Wizards menu selection under the Storage pull down menu provides 
access to:

■ Volume Configuration Wizard

■ Array Configuration Wizard

Note – Sun StorageTek Business Analytics incorporates a database extract, 
transformation, and load process for the tables in the array domain. The Storage 
Wizard functionality is based on the transformed data warehouse tables. Your 
Database Administrator can manually run the gsr_xtrt_proc_etl stored procedure to 
have the database extract, transformation, and load process run in the background at 
a desired time.

Volume Configuration Wizard
The Volume Configuration Wizard allows you to create reports about the volumes 
and their characteristics (mapped ports, physical spindles, etc.), along with the 
allocation of those volumes to hosts.  Sample reports you might create using this 
wizard include:
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■ Assigned Volumes with Copies - Create a tabular list of all the volumes and their 
associated local and remote copies.

■ Fan-Out Report - Show how many different hosts are accessing storage through 
each front-end port on the array.  Compare to your Array manufacturer’s "best 
practice" guidelines on fan-out ratios to optimize performance. 

■ Chargeback Reporting - If your organization charges different rates for different 
tiers of storage, you may wish to create an extract of the volumes and their RAID 
types by the host to which they are allocated. 

■ Disaster Recovery Relationships - For all volumes with a remote copy, display the 
server, array, volume, remote mirror, remote volume, and any hosts at the remote 
site to which that volume is allocated.

Proceed as follows.

1. Select Storage → Reporting Wizards → Volume Configuration Wizard from the 
home page.

The Step 1 of 5: Storage Volume Wizard window is displayed. You can choose to:

■ Use the Available Reports pull down list box to display a selected saved custom 
report.

■ Click Cancel to cancel.

■ Click Delete to delete a saved report you selected from the Available Reports pull 
down list box

■ Click Next to proceed with creating a new custom report.

■ View/change the report security for new report.

2. After you click Next, the Step 2 of 5: Storage Volume Wizard - Choose Columns   
window appears. 

All columns that can be selected are shown in the left-hand box.  The following 
notes apply to this window:

■ Column names must be moved to right-hand box using Add >> and Add All>> 
buttons to be displayed in the report.

■ The default maximum number of rows to be displayed is set to 300.  This can be 
changed for each time a report is executed, but the value cannot be saved.

■ In the Columns to Display box, select a Column Name and press one of the blue 
arrows to move it up or down in the list.  This is the order in which fields will 
display (left to right) in the resulting report. 

■ Exclude duplicate records is the default value.

The columns are included in one (or common to several) storage array tables in the 
Sun StorageTek Business Analytics database. 
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3. Add the columns and click Next. 

The Step 3 of 5: Storage Volume Wizard - Select Filters window is displayed. The 
following notes apply to this window:

TABLE 3-1 Volume Configuration Wizard Columns 

Column Name Description

Array ID Array identifier collected from the array (not alias 
defined using the Tools menu Alias functionality)

Array Manufacturer Manufacturer

Array Model Model

Disk id 1-4 Unique storage unit ID 1-4

Disk Size Size

Front End Controller Count Count of Front End Controllers

Front Controller WWN World Wide Name (WWN) of front end controller

Front Port WWN WWN of Front End Controller Port

Host Allocated Node WWN

Host HBA Port Host HBA Port WWN

Remote/Local Copy Status Split, Synchronized, Active

Remote/Local Copy Type BCV, Snapshot

Remote/Local Copy Target 
Volume

Remote/Local Copy volume ID

Site Name Site name

Volume Allocation Status Remote copy status

Volume ID Volume Identifier

Volume Meta Head ID Virtual Head metaLUN lun number

Volume Meta Status Current state (e.g., ENABLED)

Volume Misc Miscellaneous

Volume Size Raw (MB) Volume Raw Size

Volume Usable Size (MB) Volume Usable Size

Volume Type Standard volumes, local copies, administrative volumes, 
etc.

Volume to Front Port Mapping 
Status

Mapped/not mapped
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■ You select the Field and Operator, then enter a Value

■ To enter a relative date, syntax is "Today-n" where n represents a number of days.  

■ The last AND is ignored in the query

■ You can select two or more filters from the large box in the center and select Add 
to group them with parentheses.  The Remove button reverses this grouping.

4. Enter any optional query filter criteria and click Next. 

The Step 4 of 5: Storage Volume Wizard - Sorting window is displayed. The 
following notes apply to this window:

■ The right column on this screen determines sort order.  

■ If you do not specify a sort key, the results will be unsorted.

■ If you specify a sort key but not a sort option, the results will be sorted in 
ascending order.

5. Specify the sort order and click Next to display the Step 5 of 5: Storage Volume 
Wizard - Summaries window appears.

Specify any desired aggregate functions, such as the count (COUNT) for disk size, 
and/or how subtotal and total details will be handled in the custom report.

6. Click Finish to generate and display the custom report.

The following notes apply to this window.

■ To save a report, enter a report name and then press the Save Report button.

■ The Available Reports list box allows you to select and run a previously saved 
wizard report

■ To export data, first select an export format and then select the Export button.

Array Configuration Wizard
The Array Configuration Wizard allows you to create summary reports about all the 
arrays in your environment.  It does not provide volume-level information.  Sample 
reports you may create using this wizard include:

■ Array Users - Show which hosts are using each array in the system.  An 
administrator might use this as a rudimentary impact analysis report, so they can 
determine which users would be impacted by taking a given array off-line.  

■ Lease Expiration - Create a list of arrays whose lease expiration occurs in the next 
90 days, for example.

Proceed as follows.
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1. Select Storage → Reporting Wizards → Array Configuration Wizard from the 
home page. 

The Step 1 of 5:  Storage Configuration Wizard window is displayed. You can choose 
to:

■ Use the Available Reports pull down list box to display a selected saved custom 
report.

■ Click Cancel to cancel.

■ Click Delete to delete a saved report you selected from the Available Reports pull 
down list box

■ Click Next to proceed with creating a new custom report.

■ View/change the report security for a new report.

2. After you click Next, the Step 2 of 5: Storage Configuration Wizard - Choose 
Columns window appears. 

All columns that can be selected are shown in the left-hand box.  The following 
notes apply to this window:

■ Column names must be moved to right-hand box using Add >> and Add All>> 
buttons to be displayed in the report.

■ The default maximum number of rows to be displayed is set to 300.  This can be 
changed for each time a report is executed, but the value cannot be saved.

■ In the Columns to Display box, select a Column Name and press one of the blue 
arrows to move it up or down in the list.  This is the order in which fields will 
display (left to right) in the resulting report. 

■ Exclude duplicate records are default.

The columns are identified in the table that follows.

TABLE 3-2  Array Configuration Wizard Columns 

Column Name Description

Array Cache Cache size

Array Disk Count Total disks

Array Firmware  Firmware version

Array ID Array identifier collected from the array (not alias 
defined using the Tools menu Alias functionality)

Array Manufacturer Manufacturer

Array Model Model

Array Name Name of array collected from the array

Back Controller Count Number of back end controllers
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Count of Configured Disk Sum of data/parity disks

Count of Free Disk Sum of available disks

Count of Hot Spare Disk Sum of Hot Spare disks

Unique storage unit ID 1-3 Front End Count

Number of Front End 
Controllers

Number of Admin Volumes

Number of administrative 
volumes

Number of Allocated Admin Volumes

Number of administrative 
volumes allocated to hosts

Number of Allocated Local Copy Volumes

Number of local copy volumes 
allocated to hosts

Number of Allocated Standard Volumes

Number of standard volumes 
allocated to hosts

Number of Unallocated Admin Volumes

Number of administrative 
volumes not allocated to hosts

Number of Unallocated Local Copy Volumes

Number of local copy volumes 
not allocated to hosts

Number of Unallocated Standard Volumes

Number of Unassigned Volumes Count of unassigned volumes

Total Volumes Total number of volumes

Site Name Site name

Total Allocated Admin Capacity Sum of assigned usable administrative volumes

Total Allocated Local Copy 
Capacity

Sum of assigned usable local copy volumes

Total Allocated Standard 
Capacity

Sum of assigned usable standard volumes

Total Configured Admin 
Capacity

Sum of configured raw administrative volumes

Total Configured Capacity Sum of configured raw capacity

Total Configured Local Copy 
Capacity

Sum of assigned usable local copy volumes

Total Configured Standard 
Capacity

Sum of configured raw standard volumes

Total Disk Capacity Raw Sum of raw capacity (GB)

Total Hot Spare Capacity Sum of hot spare capacity

TABLE 3-2  Array Configuration Wizard Columns  (Continued)

Column Name Description
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3. Add the columns and click Next. 

The Step 3 of 5: Storage Configuration Wizard - Select Filters window is displayed. 
The following notes apply to this window:

■ You select the Field and Operator, then enter a Value

■ To enter a relative date, syntax is "Today-n" where n represents a number of days.  

■ The last AND is ignored in the query

■ You can select two or more filters from the large box in the center and select Add 
to group them with parentheses.  The Remove button reverses this grouping.

4. Enter any optional query filter criteria and click Next. 

The Step 4 of 5: Storage Configuration Wizard - Sorting window is displayed. The 
following notes apply to this window:

■ The right column on this screen determines sort order.  

■ If you do not specify a sort key, the results will be unsorted.

■ If you specify a sort key but not a sort option, the results will be sorted in 
ascending order.

5. Specify the sort order and click Next to display the Storage Configuration Wizard 
- Summaries Window. 

Specify any desired aggregate functions and/or how subtotal and total details will 
be handled in the custom report.

6. Cick Finish to display the custom report. 

The following notes apply to this window.

■ To save a report, enter a report name and then press the Save Report button.

Total Unallocated Admin 
Capacity

Sum of unallocated administrative volumes

Total Unallocated Local Copy 
Capacity

Sum of unallocated local copy volumes

Total Unallocated Standard 
Capacity

Sum of unallocated standard volumes

Total Unallocated Capacity Sum of unallocated capacity for all volume types

Total Usable Admin Capacity Sum of usable administrative volumes

Total Usable Local Copy 
Capacity

Sum of usable local copy volumes

Total Usable Standard Capacity Sum of usable standard volumes

Total Usable Capacity Sum of usable capacity for all volume types

TABLE 3-2  Array Configuration Wizard Columns  (Continued)

Column Name Description



Chapter 3 Storage 81

■ The Available Reports list box allows you to select and run a previously saved 
wizard report

■ To export data, first select an export format and then select the Export button.

FIGURE 3-15 Sample Array Configuration Wizard
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CHAPTER 4

Fabrics

This chapter describes the different reports available through the Sun StorageTek 
Business Analytics Management Console’s Fabrics pull down menu. The following 
topics are discussed:

■ “Fabric Trending and Forecasting” on page 83

■ “Fabric Performance” on page 85

■ “Storage Network Topology” on page 93

■ “Fabric Configuration” on page 99

Fabric Trending and Forecasting
The Fabric Trending and Forecasting report allows you to determine how many 
switch ports have been consumed in your organization. This information can be 
summarized for the site, fabric, or switch.

You can set the following options: 

■ Trending - The Trending option only looks at past consumption. 

■ Forecasting - The Forecasting option allows you to project future switch port 
requirements based upon past usage and planned projects. Use this report when 
budgeting for switch purchases, and to more accurately time purchases to match 
your needs.

■ Date Range - These fields indicate the date range that the report should use to 
calculate the forecast. If the range is less than a month long, the report will use a 
value from the end of each day to calculate the forecast. If the range is between 1 
and 6 months, the report will use a value from the end of each week to calculate 
the forecast. If the range is longer than 6 months, the report will use a value from 
the end of each month to calculate the forecast. 
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■ Forecast Period - Enter how far into the future you would like the report to 
forecast. 

■ Targeted Maximum Consumption - If you wish to maintain a reserve of ports, 
indicate the amount as a percentage of your total. In other words, if you wish to 
manage your switches to 90% maximum usage (and maintain a 10% reserve), then 
enter 90% into this field. The report will indicate the date when you can anticipate 
consuming your targeted amount of ports based on historical usage. 

1. From the Management Console Home Page, select Fabrics.

2. Select Fabric Trending and Forecasting and the Fabric Trending and Forecasting 
main window is displayed.

3. In the upper left section of the report, use the radio button to specify generating 
the trending or forecasting report.

4. Beside the "Forecast Period:" heading, use the pull-down list box to choose a 3-
months, 6-months, 1 year, or 3 years report period.

5. Beside the "Targeted Max Consumption:" input box, select the maximum 
consumption percentage (or accept the default value of 100%).

6. Set the start and end dates.

7. Click on the site, fabric, or switch in the navigation pane to generate the report for 
the respective item (e.g., site).

For an enterprise or site, the report shows the report date, number of port changes, 
number of ports available and unavailable, and the total number of ports. For a 
selected fabric or switch, the report header displays the enterprise, site, and fabric or 
switch WWN. The report data is displayed in a graph at the top section and in a 
table beneath the graph. In the graph, the maximum consumption is indicated using 
a red line and the device-specific usage information is drawn using a green line.

A sample fabric trending report is shown in FIGURE 4-1.
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FIGURE 4-1 Fabric Trending and Forecasting

Fabric Performance
The Fabric Performance report displays port performance data. Before you generate 
a fabric performance report, you specify the following options:

■ Charting Options - Allow you to generate graphs based on the selected values:

■ Reads / Received 

■ Sends /Transmitted 

■ Errors 

■ Busy 

■ Peak Received 

■ eak Transmitted 

■ Date Range - Allows you to filter the report data based on Start Date and Time 
(Hours: Minutes) and End Date and Time (Hours: Minutes).
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For the array, host, and tape library reports, performance is shown only for ports 
connected to the fabric.

1. From the Management Console Home Page, select Fabrics.

2. Select Fabric Performance and the Fabric Performance main window is displayed.

3. In the upper left section of the report, put a check in each Charting Option 
checkbox to be used in the report.

4. In the "Units on X-axis" input box, optionally specify the number of units on the 
x-axis, where n specifies the number of hours. 

These values will be independent of the graph data points.

5. Set the start date and time and the end date and time for the report.

6. By expanding the items in the navigation pane, click the device for which you 
want to generate a fabric performance report.

Fabric/Fabric Switch
The Ports in Fabric report is generated by your clicking the fabric in the navigation 
pane. A sample report for a fabric is shown in FIGURE 4-2.
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FIGURE 4-2 Ports in Fabric - Line Graphs

The top section of the report identifies the current view (Enterprise-Wide), the site 
name, the fabric WWN and name, and the date range. A separate line graph appears 
for each performance metric selected. These are depicted from the fabric switch 
perspective.

Beneath the graphs, the Asset Performance Summary and Ports Performance 
Summary tables are displayed.
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FIGURE 4-3 Ports in Fabric - Tables

The Asset Performance Summary table shows the specified performance statistics 
per fabric switch. The Ports Performance Summary table drills down to show 
performance statistics for the individual fabric switch ports. Clicking the Device 
report link displays the Detailed Switch Report, similar to the one that appears in 
FIGURE 4-4.
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FIGURE 4-4 Detailed Switch Report

The Ports in Switch report is generated by clicking a particular switch in the 
navigation pane. The report displays performance metrics for the selected fabric 
switch in line graphs and tabular format. Again, the line graphs depict performance 
from the fabric switch perspective.
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FIGURE 4-5 Ports on Switch - Line Graphs

Hosts
You can generate a Host Connections report for all hosts in a site or for a particular 
host that you select in the navigation pane. The report displays performance in both 
line graphs and tabular format. The line graphs depict the performance metrics from 
the fabric switch perspective.

The Asset Performance Summary table identifies the host name, number of fabric 
port connections, and individual performance metrics, such as average KB/sec 
transmitted and received.  Clicking the Device link displays the Detailed Host 
Configuration and Utilization report for the selected host server. 
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FIGURE 4-6 Host Connections: Site Level

The Ports Performance Summary table shows the WWN of the fabric switch port, its 
type, the host attached to the port, its HBA, and the fabric port performance metrics.

Arrays
You can generate the Arrays Connections report for all arrays in the site or for an 
array selected in the navigation pane. The report displays performance in both line 
graphs and tabular format. The line graphs depict the performance metrics from the 
fabric switch perspective. A sample array-level report is shown below.



92 Sun StorageTek Business Analytics Management Console User’s Guide • June 2006

FIGURE 4-7 Array Connections - Array-Level 

The Asset Performance table shows the array ID, number of fabric port connections, 
and the performance metrics. The Port Performance Summary identifies the array 
port WWN, type, component, and performance metrics.

Tape Libraries
You can generate the Tape Library Connections report for a tape library selected in 
the navigation pane. The report displays performance in both line graphs and 
tabular format. The line graphs depict the performance metrics from the fabric 
switch perspective.
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Storage Network Topology
The Storage Network Topology report provides a graphical depiction of the storage 
environment as collected by Sun StorageTek Business Analytics. To display the 
Storage Network Topology report, the supported version of the Sun Java Runtime 
Environment (JRE) software must be installed on your computer. If it is not installed 
on your computer, you will be prompted whether you want to install it from the Sun 
download site. 

FIGURE 4-8 Java Download Dialog

To install the required JRE, click Yes and follow the Wizard prompts to extract and 
install the software on your computer. 

If you are running JRE v. 1.4, the tool tip information is not displayed. With JRE v. 
1.5, the report may not work properly.

The top section of the navigation pane contains a Site View radio box and the Date 
input field that allows you to refresh the date. The sites in your current view can be 
displayed by expanding the Site heading. The main report window allows you to 
view an entire site, network elements under a particular fabric, or only network 
elements connected to a particular switch.
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FIGURE 4-9 Storage Network Topology - Site 

The Storage Network Topology report is divided into two panels. 

■ The left panel provides controls to enter start date for the report, a refresh button 
and a tree. 

■ Date text box allows entering start date for the report.

■ Clicking the Refresh button refreshes the navigation pane on the left side of the 
report.

■ The tree represents the hierarchy under a site in the form of Hosts, Fabrics and 
Storage.

■ The right panel shows the graphical layout for the selected element, representing 
the various network elements connected to that item.

The Tool Bar provides additional functionality that helps you to optimize the view of 
the storage network topology. Each toolbar icon and its respective function are 
described below. Refer to TABLE 4-1.

[Note: 5 of 9 icons (graphics) are corrupted in the following table.]
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TABLE 4-1 Storage Network Topology Toolbar

Icon Description

Zooms in on the topology map, keeping map centered.

Zooms out on the topology map, keeping map centered.

Selects a portion of the topology map, and zoom in on that portion.

Resizes the map to fit the screen.

Provides a magnifying glass to magnify elements on the topology map.

Opens a miniature representation of the map and allows navigation of 
the full map display.

Prints the map.

Prints the map to fit to page.

Allows exporting the map in Visio 2003 xml format.
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FIGURE 4-10 shows the connected elements under a fabric.

FIGURE 4-10 Site View: Fabric Network Elements

If information on certain network elements is unavailable, these network elements 
are collectively represented by a single device-neutral icon, displayed as a question 
mark and the designation, ’Unknown’. 

Using Tool Tips
Tool tips provide additional detail for each element in the graphical view. To view 
tool tips, mouse over a network element.

■ Host level - The tool tip contains Name, IP address, Model and OS.

■ Switch level - The tool tip contains Switch WWN, Fabric WWN, Vendor, Model, 
Active and Unused ports.

■ Fabric level - The tool tip contains Switch WWN, Fabric WWN, Vendor, Model, 
Active and Unused ports.

■ Array level - The tool tip contains Name, Array ID, Vendor and model.

Tool tip level help on connectors shows list of ids or WWNs that are the end points 
of this connector.
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Disconnected Elements View
If no connections are found between network elements at a selected level, the details 
are shown in a tabular form in the Disconnected Elements tab as shown in 
FIGURE 3-3.

FIGURE 4-11 Disconnected Elements View

Search Toolbar
Using the Search toolbar, provided at the bottom of the report as shown in 
FIGURE 5-13, you can search for any network element.

FIGURE 4-12 Search Toolbar

After you enter an array id or wwn, the interface searches the element in the 
graphical layout and selects it. Partial entries will also find a match, so a complete id 
or WWN is not required.
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Exporting to Visio 2003 format:
To export the topology map into Microsoft Visio’s XML format, proceed as follows:

1. Click on the Export to XML toolbar button that is shown in TABLE 4-1. The 
Topology Export window appears as shown below.

FIGURE 4-13 Topology Export

2. Follow the instructions that are provided on this window. 

You will need to create the .VDX file that Visio requires manually by selecting and 
copying the generated XML into a text file.

3. To view the exported topology map, you will require Visio 2003.

Note – This feature will not work if any pop up blocker is being used. Please disable 
any pop-up blocker while using the Topology report. This is especially true when 
you are using some Internet Explorer add-ins or newer versions of Internet Explorer 
with pop-up blocking functionality. AOL, Yahoo SearchBar, and the Google Toolbar 
are examples of software providing pop-up blocking functionality.



Chapter 4 Fabrics 99

Fabric Configuration
The Fabric Configuration report provides a high-level fabric summary report as well 
as the capability to obtain detailed reports on fabrics and connected hosts or storage 
arrays.

1. Select Fabrics from the Home Page.

2. Select Fabric Configuration and the top-level Fabric Configuration report appears.

FIGURE 4-14 Fabric Configuration - Top Level

3. Expand a site in the navigation Pane to view its fabrics. 

If you click the Fabric icon the Site Summary Fabric report is displayed. It shows the 
principal switch name, fabric WWN, fabric management IP address, number of 
member switches, total number of ports in the fabric, number of attached nodes, and 
the number of ISL connections for each monitored fabric.

4. Click on the plus sign (+) next to the Fabrics heading to see all the fabrics at your 
site.
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5. Clicking on a particular fabric switch in the navigation pane displays the Detailed 
Fabric Report. 

The report shows the principal switch name, the fabric WWN, the IP address where 
the Fabric Agent is installed, the number of member switches, the zoning status, the 
total number of ports in the fabric, the number of inter-switch links, and the effective 
zone set.

6. Clicking on a switch name link in the Member Switches section of the report 
displays the Detailed Switch Report. 

7. Mouse over a field (e.g., Principal Switch Name) to display help text for that field. 

This view shows the Domain ID, switch model, status, and port usage information 
in the switch detail table. View detailed port status information (port number, status, 
attached device name, attached device WWPN) in the port status table.

Expanding the Fabrics heading in the navigation pane allows you to: 

■ View the Active Zone Set and identify the zones and member of the zones 
configured in the enabled zone set.

■ View the zone sets that exist in the fabric configuration.

■ View the zones (member alias, WWN, WWPN, or port) in the zone sets.

■ View the alias name, member list, and zone containers for fabric aliases

■ View details on the member switches in a fabric.

■ View physical node connectivity details on nodes connected via the fabric.

Detailed Node Connection Report
By expanding the Arrays heading and clicking on an Array, you display the Detailed 
Node Connection report that contains the Physical Connection Summary and Zone 
Member Report tables.

The Physical Connection Summary table allows the SAN administrator to quickly 
identify how the storage adapter is plugged into the SAN. The Fabric report link 
displays the Detailed Fabric Report, and the Attached Switch report link displays the 
Switch Detailed Report. In the Zone Member Report table, "Path" is a number 
assigned to the path between the reported node and the member node.  

Detailed Switch Report
Clicking on a switch in the navigation pane displays the Detailed Switch Report.
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The Switch Detail table provides useful configuration management information, 
including the switch name/WWN, fabric WWN, vendor, model, domain ID, status, 
and number of connected zones. The Port Status table drills down to show port-level 
status and configuration details (e.g., WWN). The Fabric WWN report link displays 
the Detailed Fabric report.

Detailed Node Connection Report - Host 
To display the Detailed Node Connection Report for a host, proceed as follows:

1. Expand the Hosts heading in the navigation pane.

2. Click on the desired host and the Detailed Node Connection View report appears.

The report shows the host-to-switch connectivity. The table identifies the HBA 
vendor, the HBA model, the effective speed, the link status, the World Wide Node 
Name and WW Port Name, and the HBA firmware version running on the adapter.

Clicking on a WW Port Name link displays the HBA Connection View report that 
identifies the host’s connectivity to the storage array’s Front End Controller.

Detailed Node Connection Report - Host 
To display the Detailed Node Connection Report for a library, proceed as follows:

1. Expand the Tape Library heading in the navigation pane.

2. Click on the desired library and the Detailed Node Connection Report appears for 
that library. 

The report shows the Library-to-switch connectivity.
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CHAPTER 5

Backup and Restore

This chapter describes the different reports available through the Management 
Console’s Backup/Restore pull down menu. You must be assigned Backup 
Administrator privilege using User Administration to access the Backup Exceptions, 
Meta Database Capacity, Real Time Events, Backup Exposure, and TSM Daily 
Administration reports. Refer to the User Administration section of the 
Administration documentation to obtain additional information.

TABLE 5-1 provides an overview of the reports provided by Sun StorageTek Business 
Analytics Release 5.1 that correlate data from backup applications, managed servers, 
and tape libraries to provide a comprehensive view of corporate data protection and 
compliance.  For a detailed list of supported backup software versions and tape 
library models, see the Sun StorageTek Business Analytics Support Matrix.

TABLE 5-1 Backup Reports Summary 

Report Type Report Task

General Backup 
Application Reports

Backup Exposure Spot possible data protection issues by identifying Sun 
StorageTek Business Analytics-managed servers which are not 
backed up.

Meta Database 
Capacity

Analyze backup catalog disk utilization over the specified time 
interval.

Legato and 
NetBackup 
Application Reports

Backup/Restore Job 
Summary

View successful jobs, unsuccessful jobs, total jobs, and backed 
up GB over a specified date range.

Media Trending Plan tape library media purchasing based on tape library 
utilization over a specified time interval.

Meta Database 
Capacity

Analyze the backup catalog disk utilization over the specified 
time interval. The Calendar function in the navigation pane 
allows setting both a date and a time (hh:mm) for filtering 
extracted data.

Job Report Wizard Create customized reports related to backup jobs information.
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The following topics are discussed in this chapter:

■ “Reporting Wizards” on page 105

■ “Backup/Restore Job Summary” on page 121

■ “Backup Exceptions” on page 123

■ “Media Trending” on page 125

■ “Backup Schedules” on page 128

■ “Meta Database Capacity” on page 130

■ “Real Time Events” on page 134

■ “Backup Exposure” on page 136

■ “TSM Daily Administration” on page 138

Media Report 
Wizard

Produce customized reports related to backup media.

Backup Success 
Wizard

Analyze performance of backup success metrics.

NetBackup Specific 
Application Reports

Backup Exceptions Show all hosts, file systems, and databases that are not part of 
an active backup job.

Backup Schedules Display types of backups scheduled for a seven day period as of 
the current date. Provides a graphical depiction of various types 
of backup operations, including all scheduled, full, user backup, 
user archive, and cumulative-incremental for that week.

Media Report View detailed information on backup media that includes the 
media ID, barcode, media type, master server, robot slot, and 
library ID.

Tivoli Storage 
Manager Reports

TSM Daily 
Administration

The TSM Event Summary report provides access to site-level 
and server-level reports on scheduled TSM events. 
Comprehensive reports provide information on Events, 
DB/Log, Migration, Expiration Disk Pools, Reclamation 
Reclaimable Tapes, and Tape Devices for the TSM backup 
application.  Detailed information is presented in application-
specific terminology, providing relevant data for backup 
managers and staff.

TSM Event 
Summary

View the overall health of all TSM servers at a site.

TSM Reporting 
Wizards

Create or view custom reports based on TSM job/event status 
and success, occupancy, or media.

Tape Libraries View configuration, status and statistics on monitored tape 
libraries.

TABLE 5-1 Backup Reports Summary  (Continued)

Report Type Report Task
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■ “TSM Event Summary” on page 143

■ “Tape Libraries” on page 151

■ “Library Asset Report” on page 151

■ “Global Status Report” on page 152

■ “Library Statistics Report” on page 155

■ “Backup Media Search” on page 156

■ “Tape Drive Allocation” on page 159

Reporting Wizards
The Reporting Wizards menu selection provides access to the following report 
wizards:

■ Job Report Wizard

■ Media Report Wizard

■ Backup Success Wizard

The reporting wizards allow you to create custom reports based on data in the Sun 
StorageTek Business Analytics backup tables.  You specify a list of data columns, 
filters, and sorting criteria to formulate the SQL query used to extract the report 
data. 

In addition, you can now use aggregate functions in the custom reports that are 
generated using the reporting wizards. Functions are keywords in SQL that are used 
to manipulate values within columns for output purposes. A function is a command 
always used in conjunction with a column name or expression. An aggregate 
function is used to provide summarization information for an SQL statement, such 
as counts, totals, and averages. The aggregate functions in the wizards include 
COUNT, SUM, MAX, MIN, and AVG. 

The reporting wizard screens may have the following buttons enabled:

■ Delete - Delete a specified existing view. Is not enabled when creating a new view

■ Back - Return to previous screen.

■ Next - Go to next step in the process.

■ Finish - Skip the remaining steps and display the view based on the current query 
criteria.

■ Cancel - Abort process and exit.

■ Close - Close a displayed report.
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For report security, you can only see private reports which you created.  You can also 
see reports that other users created and share globally (all users).  The group share 
option is currently unimplemented.

Job Report Wizard
The Job Report Wizard allows you to create, save, and display a custom report 
regarding backup jobs stored in the Sun StorageTek Business Analytics database.

1. Select Backup/Restore → Reporting Wizards → Job Report Wizard from the Home 
Page. 

The first page of the Job Report Wizard appears. You can choose to:

■ Create a new report

■ Delete an existing report (if any exists)

■ Verify/change how a report is shared as (Global or Private) 

■ Generate a report using existing saved parameters through the Available Reports 
list box

2. Click Next>> on the Job Report Wizard window and the Step 2 of 5: Job Report 
Wizard - Choose Columns window. 

The Columns Available list box is a scrollable, multi-select list box that displays the 
list of columns available for inclusion and the order to display them in the final 
view. Initially, no columns appear in the Columns to Display list box. After you add 
fields to the Columns to Display list box, you can highlight a field and click the Up 
or Down arrow to move the field up or down, respectively. 
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FIGURE 5-1 Step 2 of 5: Job Report Wizard - Choose Columns 

3. Add/remove columns to the new (or existing) report and click Next>>. 

The Step 3 of 5: Job Report Wizard - Select Filters window appears. It allows you to 
specify rules to filter the extracted rows of data and, thereby, add constraints to the 
database query.
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FIGURE 5-2 Step 3 of 5: Job Report Wizard - Select Filters

The data types for the fields are identified in TABLE 5-2.

TABLE 5-2  Job View Field Data Types 

Field Data Type

Job ID String

Joy Type Numeric

Client List

Class/Group List

Schedule List

File List String

Start Date Date

Elapsed Time Date

Backup Server List

Expiration Date Date
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The Operator drop-down list box contains a list of operators that are valid for the 
chosen field.  The relationship between the fields and the operators is described in 
TABLE 5-3.

The type of control in the value column also depends on the data type of the field 
chosen, as shown in the following table.

BKB Numeric

Backup Level List

Job Status String

Nbr Files Numeric

Nbr Copies Numeric

Nbr Fragments Numeric

Error Message String

MB/sec Numeric

Storage Unit List

Compressed Boolean

Encryted Boolean

Client Version String

TABLE 5-3 Data Types and Valid Operators

Data Type Valid Operators

Numeric =, <>, >, >=, <, <=, IN

Date =, <>, >, >=, <, <=, IN

String Equal To, Like, In

List IN

Boolean =, <>, IN

TABLE 5-2  Job View Field Data Types  (Continued)

Field Data Type
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4. Set any optional constraints to the database query in the Select Filters window 
and click Next>>. 

The Step 4 of 5: Job Report Wizard - Sorting window appears. It allows you to select 
the fields to be sorted when data returns. By default, returned data is sorted in 
ascending order. Customize your sort criteria to sort in ascending or descending 
order using the Sort Options radio box for a selected field.

5. Click Next to display the Step 5 of 5: Job Report Wizard - Summaries window.

The Summaries window allows you to:

■ Specify the aggregate function, such as SUM, AVG, MAX, MIN, COUNT or 
COUNT (distinct), to be applied to the selected column each time that it changes 
in the report. 

■ Exclude subtotal details and show only summarized details in the report.

TABLE 5-4 Data Type and Control Types 

Data Type Valid Operators
Control 
Type(s) Value Types

Numeric =, <>, >, >=, 
<, <=, IN

Data Entry 
Field

Single value (e.g. 999)
OR
a set of values (e.g. 1, 2, 150 in the case of 
the IN operator is selected)

Date =, <>, >, >=, 
<, <=, IN

Calendar 
Widget + 
Data Entry 
Field

Single value (e.g. 12/31/2002)
OR
a set of values (e.g. 12/01/2002, 
12/02/2002, 12/31/2002 in the case of the 
IN operator is selected)

String Equal To, 
Like, In

Data Entry 
Field

Single value (e.g. "Oracle Backups")
OR
A set of values (e.g. "Oracle Backups", 
FSBackups, MSSQL in the case of the IN 
operator is selected). Strings with white 
space must be double-quoted.

List IN Drop-Down 
List Box

A set of values based on the actual valid 
values for that field in the database (e.g. 
"Oracle Backups", FSBackups, MSSQL in 
the case of the IN operator is selected to 
operate on the Class Type field). Strings 
with white space must be double-quoted.

Boolean =, <>, IN Static Drop-
Down List 
Box

Single value (e.g. Y) chosen from the 
possible values Y or N.



Chapter 5 Backup and Restore 111

■ Show a grand total, which is based on a specified aggregate function (e.g., 
COUNT) applied to some specified column.

FIGURE 5-3 Step 5 of 5: Job Report Wizard - Summaries

6. Click Finish to display the report. 

Optionally type a name for the report in the Report Name input box and click Save 
Report if you want to save the report for subsequent use.
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FIGURE 5-4 Sample Job Report Wizard Report

Media Report Wizard
The Media Report Wizard allows you to create custom reports related to backup 
media for Veritas/Legato stored in the Sun StorageTek Business Analytics database. 
Proceed as follows:

1. Select Backup/Restore → Reporting Wizards → Media Report Wizard. 

The Step 1 of 5:  Media Report Wizard window appears. It allows you to specify 
whether you want to:

■ Create a new report

■ Delete an existing report (if any exists)

■ Verify/change how a report is shared as (Global or Private) 

■ Generate a report using existing saved parameters through the Available Reports 
list box
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2. Select an existing report or simply click Next>> to create a new report. 

The Step 2 of 5: Media Report Wizard - Choose Columns screen appears. 

FIGURE 5-5 Step 2 of 5: Media Report Wizard - Choose Columns

3. Select the data columns for the media report. 

To do so, highlight a column and click Add>> or click Add All>> to add all the 
columns from Columns Available to Columns to Display. 

4. Click Next>> and the Step 3 of 5: Media Report Wizard. 

The Select Filters screen appears. TABLE 5-5 lists the data types for the fields you can 
choose to construct a filter. 

TABLE 5-5  Media Report Field Data Types 

Field Data Type

Volume ID String

Media Type List

Bar Code String

Volume Pool List
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5. Set any optional filters or constraints for the database query and click Next>>. 

The Step 4 of 5: Media Report Wizard - Sorting window appears.

6. Set up the sort order or accept the default sort order (ascending) and click Next to 
display the Step 5 of 5: Media Report Wizard - Summaries window.

The Summaries window allows you to:

■ Specify the aggregate function, such as SUM, AVG, MAX, MIN, COUNT or 
COUNT (distinct), to be applied to the selected column each time that it changes 
in the report. 

■ Exclude subtotal details and show only summarized details in the report.

■ Show a grand total, which is based on a specified aggregate function (e.g., 
COUNT) applied to some specified column.

7. Click finish to generate the custom report based on media in the database.

If desired, enter a report name in the Report Name field and click Save Report to 
save the new/edited report. 

A sample media report is shown in FIGURE 5-6.

Pool Type List

Robot List

Roblt Slot Numeric

Create Date Date

Last Mount Date Date

Nbr of Mounts Numeric

Expiration Date Date

Last Written Date

Last Read Date

Max Mounts Numeric

Retention List

Media Status List

Nbr Images Numeric

Location String

TABLE 5-5  Media Report Field Data Types  (Continued)

Field Data Type
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FIGURE 5-6 Sample Media Report Wizard Report

Sample Media Reclamation Report
The Media Report Wizard may be used to create reports that assist you in 
monitoring tapes for reclamation within your tape vaulting strategy. An example 
follows.

1. Select Backup/Restore → Reporting Wizards → Media Report Wizard. The Step 1 of 
5:  Media Report Wizard window appears. 

2. Select to create a new report and click Next> to continue. 

The Step 2 of 5: Media Report Wizard - Choose Columns window appears. Highlight 
the columns in the Columns Available selection box and click the Add>> button to 
specify these columns are to be displayed in the report. 

In this example, the Volume ID, Master Server, Media Type, Volume Pool, Expiration 
Date, Last Mount Date, KB Written, Unexpired Images, and Location columns are 
selected.
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3. Click Next>> to display the Step 3 of 5: Media Report Wizard - Select Filters 
window. 

Use the default "Snapshot" and Expiration Date columns to filter the media that will 
be selected by the SQL Query. 

4. Click Next>> and the Step 4 of 5: Media Report Wizard - Sorting window appears.

Add the sort keys to the SQL Query.

5. Click Next>> and the Step 5 of 5: Media Report Wizard - Summaries window 
appears.

Add any aggregate functions (e.g., SUM) that will be applied each time the specified 
columns change in the report.

6. Click Finish to generate the report.

Backup Success Wizard
The Backup Success Report Wizard allows you to create custom daily performance 
reports related to backup report metrics that you specify.  Proceed as follows:

1. Select Backup/Restore → Reporting Wizards → Backup Success Wizard. 

The Step 1 of 3: Select Date Range screen appears. 
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FIGURE 5-7 Step 1 of 3: Select Date Range

2. Select a date/time range. The default value for End data is today, current time. 

The default value for the start date is today - 30 days, midnight local time.  Clicking 
the Cancel button exits the wizard.  Clicking Next>> you to Step 2 of the parameter 
selection wizard. Clicking Finish skips the rest of the steps and the report is created 
using default values from here.

3. After you set the date range and click Next>>, the Step 2 of 3: Select Report 
Metrics screen appears.
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FIGURE 5-8 Step 2 of 3: Select Report Metrics

4. Choose at least one but no more than two of the following report types and click 
Next>> to display the Step 3 of 3: Choose Filters window.

■ Jobs % Success

■ Total Jobs

■ Successful jobs

■ Failed jobs

■ Backed up GB (BGB)

■ Number of Clients
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FIGURE 5-9 Step 3 of 3: Choose Filters

5. On the Step 3 of 3: Choose Filters window, the Jobs Success/Failure check box tells 
the system whether to interpret error code 1’s as a success or failure. 

The default value is on. The Advanced Failure Codes button takes you to an 
additional dialog that allows you to specify specific error codes as failures.  The 
default value is ALL failure codes are counted as failures.

The Job Type radio group allows you to filter jobs by backup type (e.g., Backups 
Only). The default job type is backup only.

The Backup Levels check box tells the system which backup levels to include as a 
part of the database search criteria.  The default value for the checkbox is disabled 
(unchecked).

The Advanced Backup Levels button takes you to an additional dialog that allows 
you to specify specific backup levels to include in the search. By default, ALL 
backup levels are included in the search.
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6. Choose the filters and click Finish to display Backup Success View for the 
specified date range appears. I

nitially, the report displays all sites managed by the user. Report metrics, such as 
report metrics % Success, Total Jobs, Successful Jobs, Failed Jobs, BGB, Nbr Clients, 
selected for all sites appear in the right pane using a line chart and tabular format.

FIGURE 5-10 Backup Success Report

Clicking the New Analysis button returns you to Step 3 where you can set new 
filters for another database query.

Note – The Client/Policy radio group you allows you to select whether to display a 
list of clients or a list of policies in the deepest level of the navigation pane 
underneath master server.
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Backup/Restore Job Summary
The Backup/Restore Job Summary report provides a listing of all backup jobs 
collected throughout an enterprise.  It allows you to navigate to a specific client’s 
jobs to determine the job history for a specific period of time.  The report 
incorporates two levels:

■ A summary level (the Job Summary sub-report) which displays successful, failed, 
and total job counts as well as the number of backed up gigabytes (BGBs) for each 
site and backup client.

■ A detail level (the Job Details sub-report) which displays the individual backup 
job details including job ID, job status, start time, duration, etc. for each job in the 
given period.

The navigation tree begins at the site level and allows you to drill down to a specific 
backup client in any site.

FIGURE 5-11 Backup Restore Job Summary (Site Level)
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After you select a site in the navigation tree, the Job Summary pane displays a 
summary of the job counts as well as the backed up gigabytes (BGBs) for that site.  
The job counts for all backup clients in a site are displayed after you click on the site 
name hyperlink in the Job Summary pane.  

FIGURE 5-12 Job Summary (Client Level)

You display the Job Details report by either:

■ Clicking a specific client in the navigation pane.

■ Clicking a specific client in the Job Summary pane.
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FIGURE 5-13 Job Details

The Job Details report identifies the backup application, job identifier, start date, 
duration, end date, file system, server name, and total amount backed up/restored, 
and the amount per second.

Backup Exceptions 
Backup Exceptions is a Veritas NetBackup only report that provides summary-level 
information on backup clients that have backup exceptions (failures, warnings, jobs 
never started) over a given time period. The report is available at the site, master 
server, and client or policy level and covers the last two days by default. This report 
provides information based on backup clients and schedules, not individual backup 
jobs.  

Proceed as follows:

1. Select Backup/Restore from the Home Page.
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2. Select Backup Exceptions. The Select Date Range control panel screen appears. 

3. Specify the desired date and time range and click Generate Report. 

The top-level Backup Exception report appears for the specified time interval. The 
report pane shows in a bar graph the number of backups jobs that never started and 
the number of failed jobs. The data used to produce the bar graph appears beneath it 
in a table.

FIGURE 5-14 Backup Exceptions

By expanding a site in the navigation pane, you view a listing of all master servers 
contained within that site. Select a desired site in the navigation pane and the bar 
graph and table update showing all the master servers for the selected site.

Each master server has unique clients and policies (NetBackup) in their 
configuration. These appear in the navigation pane. You can obtain additional 
information on backup job exceptions for a desired master server by:

■ Choosing to update the information by client (default) or by policy using the 
radio button

■ Clicking on the desired master server in the navigation pane
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If you select to view backup exceptions by client, the table data will show a list of 
clients for that master server that have exceptions. The bar graph does not change. If 
you select to view backup exceptions by policy, the table data shows a list of policies 
that have exceptions. Again, the bar graph does not change.

Each client or policy may be associated with backup exceptions that are categorized 
as either a backup job that never started or failed. Clicking on a particular client or 
policy in the navigation pane displays a list of backup exceptions that exist in the 
database for the selected date and time range, where the default report range is the 
previous day.

Media Trending
The Media Trending Report allows you to generate backup media trending graphs 
for media utilization and capacity management analysis for Veritas NetBackup and 
Legato NetWorker.  The report provides an estimation of future trends based on the 
results of a database search for media that match the your search criteria. 

The Media Trending Report allows you to provide a number of parameters:

■ A list of media pools - Allows you to narrow search criteria to one or more 
specific media pools.  The default value for this parameter is all media pools.

■ A list of media types - Allows you to narrow search criteria to one or more 
specific media types.  The default value for this parameter is all media types.

■ Media Expiration Days - Matches volumes due to expire within the number of 
days provided.  This is used within media availability forecasting.  The default 
value for this parameter is seven days.

■ Originally Written Months - Matches volumes which where originally written 
more than N months ago. Because magnetic media does not have an infinite life 
expectancy, this parameter can help to identify media volumes first written long 
enough ago to be considered suspicious.  The default value for this parameter is 
48 months (i.e. four years).

■ Mounted At Least N(umber) Times - Matches media volumes that have been 
mounted at least "N" times.  This is another parameter that helps identify media 
that is reaching its life expectancy.  The default value for this parameter is 50 
times.

■ Read at Least N(umber) Times - Matches media volumes that have been read 
from at least "N" times.  This parameter helps to identify media volumes with the 
most restore activity.  The default value for this parameter is four times.

You can select a date range to be used for forecasting using the following choices:
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■ Daily Trend - Provides a default search range of sixty days for a daily media 
trend.  Media counts for each calendar day are calculated for the sixty day range 
and used to generate a forecast.

■ Weekly Trend - Provides a default search range of sixty days for a weekly media 
trend.  Media counts for the beginning of each calendar week are calculated for 
the 60 day range and used to generate a forecast.  The default date range can be 
overridden to a maximum of 365 days.

■ Monthly Trend - Provides a default search range of sixty days for a monthly 
media trend.  Media counts for the first day of each calendar month are calculated 
for the sixty day range and used to generate a best-fit forecast.  The default date 
range can be overridden to maximum of 5 times 365 or 1725 days.

FIGURE 5-15 Backup Media Capacity Trending - Choose Parameters



Chapter 5 Backup and Restore 127

After you enter the report parameters, click Finish to generate the report.  The report 
contains a left-hand navigation pane that lists all the sites in the environment and 
expands to list all of the backup servers in each site.  You can produce a media 
trending report for the entire environment, an entire site, or a specific backup server.

The right-hand report pane consists of two objects:

■ A line chart at the top containing a graphical representation of the results of the 
database search - including the prediction.

■ A table below the chart containing the raw data used to draw the chart.

FIGURE 5-16 Media Capacity Trending

 The report contains media counts for four distinct media statuses: 

■ Available Media - Media in the backup server media database available for 
writing.  For Veritas NetBackup, available media volumes are volumes that are 
not Full, Suspended (either manually or taken off-site), Imported (from another 
NetBackup server), or Frozen.  For Legato NetWorker, an available volume is a 
volume that is not full, eligible for recycling, and not read-only.

■ Full Media - Media in the backup server media database available that is full.
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■ Nearline Media - Media in the backup server media database available that 
currently resides in a tape library.  

■ Total Media - All media in the backup server media database.

Backup Schedules
The Backup Schedules report displays the types of backups scheduled for a seven 
day period as of the current date. It provides a graphical depiction of various types 
of backup operations, including all scheduled, full, user backup, user archive, and 
cumulative-incremental for that week. The report is available by site.

At the site level, the Backup Schedule Report displays the backup schedules as 
follows:

■ Organized by each day of the week

■ Shown for each Veritas NetBackup server in the environment and for the current 
calendar week.  

This includes automatic schedules such as full and incremental backups as well as 
on demand type backup schedules such as client-initiated user backups and 
archives. 

The Backup schedule Report contains two sections:

■ A graphical view containing a visual mapping of the backup scheduled start 
window for all the clients and schedules for the current calendar week.

■ A tabular listing of the backup schedules.

1. Select Backup/Restore → Backup Schedules from the Home Page. 

The Step 1 of 3: Select Site screen appears.

2. Select the site from the drop down box and click Next>>. 

If you select a site that does not have a master server configured, a dialog box is 
displayed that states no master servers exist at the site.

3. Specify the backup master server on the Step 2 of 3: Select Master Server screen 
and how data extraction is filtered. 

The selection criteria consist of by client or by policy. The radio group, Filter By, 
defaults to "by client". The filter you select determines if a list of backup clients or a 
list of policies or classes appears on the last step of the process.
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FIGURE 5-17 Step 2 of 3: Select Master Server

4. Review/select the backup master server and accept the default filter or click the by 
Policy radio box. Click Next>>. 

The Step 3 of 3: Choose (Client) or Choose (Policy) screen appears. 

5. Highlight (select) a field in the Available Client (or Policy) table and click Add> 
to add it to the Chosen Client (or Policy) table. 

To add all available fields to the Chosen table, click Add All>>. Use the <Remove or 
<<Remove All controls to selectively remove or remove all existing fields from the 
Chosen table.

6. Click Finish and the Backup Graphical Schedule View appears. 

It provides a graphical (and tabular) depiction of various types of backup 
operations, including all scheduled, full, user backup, user archive, and cumulative-
incremental for that week. The Schedule Graph uses colors, as described in TABLE 5-6.
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By clicking the Display Table control button, you can view the specific backup jobs 
by class in a tabular format that make up the schedule graph.

The tabular view displays the class, schedule, schedule type, the open window, the 
close window, as well as the frequency of scheduled backups.

Meta Database Capacity
The Meta Database Capacity report is an administrative report that allows backup 
application administrators to monitor the size of the backup application’s meta 
database and the available space disk allocated to contain it over a specified date 
range. 

TABLE 5-6  Description of Schedule Graph Colors

Color Legend Description

Pink Full All files designated are backed up

Yellow Incremental Only files modified since last backup 
are backed up

Green User Backup Files specified by the user are to be 
backed up

Light Blue User Archive Files specified by the user are archived.  
An archive is a backup with a deletion 
of the original files.

Red Cumulative-
Incremental

Only files modified since last archive 
are backed up.

Dark Blue All Schedules
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FIGURE 5-18 Meta Database/Free Space Capacity

The term meta database is a generic term that is used to describe the Legato 
NetWorker and Symantec NetBackup applications.  It refers to the backup 
application’s combined configuration, backup history, and media databases.  Each 
backup application has its own nomenclature for these databases. However, the meta 
database concept applies to both backup products.  

Veritas NetBackup
The meta database in Veritas NetBackup is called the NetBackup catalog.  It resides 
on the NetBackup master server.  They normally exist in 
/usr/openv/netbackup/db/images on Unix and <drive>:\Program Files\
VERITAS\NetBackup†b\images on Windows.  For the Meta Database Capacity 
report, it is the size of the database files on disk that determine the size the database. 
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That being said, it is the size of the file system (or file systems) in which the files 
exist (more specifically, the available space on those file systems) that determine the 
available space.

To determine file system available space on a host, Sun StorageTek Business 
Analytics uses a Sun StorageTek Business Analytics Host Agent.  For this reason, a 
prerequisite of the Meta Database Capacity report for NetBackup is that both a 
NetBackup Agent and a Host agent are installed on the NetBackup master server.  
For NetBackup, the Meta Database Capacity report plots the size of the files systems 
containing the NetBackup catalog and their available space on a chart in the report, 
allowing a NetBackup administrator to determine if there may be a problem.

Legato NetWorker
The meta database in Legato NetWorker is called the index database.  It resides on 
the NetWorker server. The NetWorker indexes normally exist in /nsr/index on Unix 
and <drive>:\Program Files\nsr on Windows.  For the Meta Database Capacity 
report, it is the size of the database files on disk that determine the size the database.  
It is the size of the file system (or file systems) in which the files exist (more 
specifically, the available space on those file systems) that determine the available 
space.

Therefore, a prerequisite of the Meta Database Capacity report for Legato NetWorker 
is that both a Legato Agent and a Host agent are installed on the Legato server.  For 
NetWorker, the Meta Database Capacity report plots the size of the files systems 
containing the NetWorker indexes and their available space on a chart in the report, 
allowing the Legato administrator to determine if there may be a problem.

Media Report
To assist the backup administrator in maintaining a media inventory, the Media 
Report provides detailed information on backup media used in the Sun StorageTek 
Business Analytics environment over a user-specified interval. The report is 
available at the view, site, or backup server levels. 
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FIGURE 5-19 Site Level Media Report

By clicking the calendar icon, the control pane allows you to specify the start date 
and end date for the report. 

For each media in the database, the report shows the media ID, bar code, media 
type, master server, robot, robot slot, library Id, media status, expiration date, MB 
written, number (Nbr) of images, number of unexpired images, volume pool, pool 
type, location, number of mounts, number of restores, last mount date, last written 
and last read timestamps, create date, the maximom number of mounts, and the 
retention. 
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Real Time Events
The Real Time Events report allows the backup administrator to quickly identify 
which backup jobs are failing. The report requires the NetBackup SNMP Extension 
(formerly called Event Notification Extension) software package is installed on the 
NetBackup master server and is configured to send its job completion traps to the 
NetBackup Agent on that master server. The Realtime Events Report contains 
NetBackup jobs collected within the last 24 hours.  You can refresh the report at any 
time by pressing the Refresh Report button.  Otherwise, you can turn on the auto-
refresh parameter which results in the report refreshing every five minutes.

The left-hand panel displays a navigation tree containing all the sites in the 
environment along with a percent success for that site.  Each site expands into a list 
of policies collected for that site.  If the success rate is greater than or equal to 95 
percent, the percentage will be displayed as green.  If the percentage is less than 95 
percent, the percentage will be displayed as red.

The right-hand report pane displays the job event detail. This includes the job ID, job 
schedule name, schedule type, end time of the job and the completion status
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FIGURE 5-20 Backup Event List

By clicking a job ID, the details of the job appear in a separate window. These 
include a description of the file list and more detailed explanation of the job status.
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FIGURE 5-21 Real Time Events Job Details

Backup Exposure
The Backup exposure Report uses data from backup agents (including TSM, 
NetBackup and Legato) and host agents to find backup exposure in an environment.  
It can serve two purposes:

■ Identify potential backup clients in the enterprise that are not being backed up.

■ Identify backup clients that do not have a Storability Host Agent installed.

By identifying servers not equipped with a Host Agent, the Backup Exposure Report 
can serve as a Sun StorageTek Business Analytics management report. For asset 
management and other storage resource management purposes, it may be optimal to 
have host agents installed on all important servers in the enterprise. 



Chapter 5 Backup and Restore 137

However, the primary purpose of Backup Exposure Report is to help identify 
potential backup clients in the enterprise that are not being backed up.  For optimal 
usability, the following prerequisites must be satisfied:

■ There must be a Storability Host Agent running (either locally or remotely) for all 
potential backup clients. These may be a local Host Agent or a remote Remote 
Host Agent.

■ A valid and accurate IP address for each TSM backup client (node) must exist in 
the NODES table in the TSM database. 

The control pane contains a checkbox at the top that allows you to hide hosts that 
you have excluded through the selection box in the report pane. You can use the 
Calendar and Refresh button to refresh the report to a selected date.

FIGURE 5-22 Sample Backup Host Exposure Report

The "Hosts not associated with Backup clients" table identifies hosts not identified in 
the database as being a backup client. For these hosts, the columns identify the site, 
host name, the host’s IP address, and host ID.

The "Backup clients not associated with a host agent" table identifies the site name, 
backup client, the backup client’s IP address, the backup server, and the policy. 
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The report allows you to suppress a host that is not backed up by design from being 
displayed in future reports.  To exclude a server from being displayed in future 
reports, click the selection box associated with that server and click Exclude. 
Conversely, click the selection box associated with a server and click Include to have 
the server reported when you refresh the report

TSM Daily Administration
The TSM Daily Administration Report provides a TSM administrator an overview of 
the performance of the TSM environment over the previous 24 hours or over the 
course of a configured backup window.  It consists of a main summary report that 
reports a status of all the TSM servers in a site or a single TSM server and a number 
of detailed sub-reports.  You may want to disable access (see User Administration in 
the Administration chapter) to this report for non-TSM administrators.

1. Select Backup/Restore → TSM Administration from the home page. 

The TSM Daily Status main window is displayed. Your view appears at the top level 
of the navigation pane. You can click on a site to generate a site-level report or 
expand the site to choose a particular TSM server and generate a server-level status 
report.
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FIGURE 5-23 TSM Daily Status - Site Level

2. The following TSM server functions are reported on in the TSM Daily 
Administration report:

■ Scheduled Events Completed, Failed or Missed status

■ TSM database and log status

■ Expiration duration and status

■ Migration duration and status

■ Disk pool status utilization

■ Reclamation status

■ Suspect tape listing

■ Tape library and drive status

A red (critical)/yellow (warning)/green (OK) indicator is displayed on the main 
report next to each of the critical status areas.  These indicators alert the TSM 
administrator at a glance to a critical or degraded performance condition.  The 
thresholds parameters that control the color of each status indicator are administered 
using TSM Report Parameters, which is accessed under the Tools pull down menu.
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3. The table beneath the pie chart provides links to the following reports:

■ Aggregate % Completion Success - Click this report link to display the Scheduled 
Event Completion Summary report showing the aggregate backup schedule % 
success data in tabular format.

■ MAX DB Utilization % - Click this report link to display the Database Status 
Summary report showing the server name, percentage of capacity utilized, and 
largest database percentage utilization in the site.

■ MAX Log Utilization % - Click this report link to display the Database Status 
Summary report showing the server name, percentage of capacity utilized, and 
largest transaction log percentage utilization in the site.

■ Read Only/Offline Disk Pool Volumes - Click this report link to display the Disk 
Pool Volumes report showing an aggregate status of the disk pool volumes used 
by all the TSM servers in the site. The status indicators are described as follows:

■ A status of "None" (with a green indicator) means that all disk pool volumes 
are "ONLINE" and "READWRITE". 

■ A status of "Warning" (with a yellow indicator) indicates at least one but < 10 
% of the total volumes in any disk pool are either not "ONLINE" or not 
"READWRITE".  

■ A status of "Error" (with a red indicator) indicates that > 10 % of the disk pool 
volumes in any disk pool are not "ONLINE" or not "READWRITE".  

■ Reclamation Failures: - Click this report link to display the Reclamation Status 
report showing the reclamation sessions used to move data from a set of 
fragmented tapes to a smaller number of tapes.

■ Suspect Tapes - Click this report link to display the Suspect Tapes report showing 
tape pool volumes with a status unequal to "READWRITE".

■ MAX Expiration Duration - Click this report link to display the Expiration Status 
report showing the server name and duration of the longest expiration process for 
the previous day (or other specified report interval).

■ MAX Migration Duration - Click this report link to display the Migration Status 
report showing the server name and duration of the longest migration process for 
the previous day (or other specified report interval).

■ MAX Migration (GB) - Click this report link to display the Migration Status report 
showing the server name and amount of data migrated during the migration 
process for the previous day.  

■ Disk Pool Count > 80% Utilized - Click this report link to display the Disk Pools 
Volume report showing an aggregate status of the % utilization of the disk pools 
used by all the TSM servers in the site. 

■ A status of "None" (with a green indicator) means that all disk pools are < 80% 
utilized.

■ A status of "Warning" (with a yellow indicator) indicates at least one disk pool 
is at least 80% but less that 90% utilized.  
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■ A status of "Error" (with a red indicator) indicates that at least one disk pool is 
> 90 % utilized.  

■ Tape Volumes Reclaimable (>65%) - Click this report link to display the 
Reclaimable Tapes report showing an aggregate status of the reclamation 
processes that ran during the previous day on all the TSM servers in the site.  

■ A status of "None" means that all reclamation processes ran successfully.

■ A status of "Warning" means that at least one but < 10% of all reclamation 
processes failed. 

■ A status of "Error" means that > 10% of all reclamation processes ran at the site 
failed.  

■ Tape Drives/Paths - Click this report link to display Tape Devices report showing 
an aggregate tape path status for the site.  

■ A status of "Online" (green) indicates all servers in the site have no tape paths 
in an offline state.

■ A status of "Warning" (yellow) indicates at least one server in the site has at 
least one tape path in an offline state but < 10% of that server’s tape paths 
offline.  

■ A status of "Error" (red) indicates at least one server in the site has > 10% of its 
tape paths in an offline state.  

Note – Refer to the TSM Report Parameters section of the Administration chapter to 
obtain information on how to set the thresholds that are associated with TSM 
parameters shown in the TSM Daily Administration report.

You can display the following sub-reports for a selected site or TSM server by 
clicking on the respective heading in the navigation pane:

■ Events - Displays the Scheduled Event Details report for the given site or server. 
It provides a complete event listing for the specified date range. The event details 
include the scheduled start, actual start, duration, activity, and status.   

■ DB/Logs - Displays the Database Status Summary report that shows an overall 
status of both the TSM database and transaction log for specified date range. The 
TSM server contains a database whose primary purpose is to manage backup 
history (i.e. metadata) and media information.  This database also contains TSM 
server configuration, security, activity logging information.  It operates and is 
managed much like other databases.  It contains a database and a transaction log.    

■ Migration - Displays the Migration Status report that shows all the migration 
event detail for the last 24 hours.  It displays both scheduled and non-scheduled 
(server-initiated) data migrations events for the TSM servers in the environment.  
Migration is a process on the TSM server that moves data from one storage pool 
to another (e.g. from disk to tape) based on a configured set of pool attributes.  
Many TSM administrators choose to migrate data only outside the backup 
window.
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■ Expiration - Displays the Expiration Status report that shows all the expiration 
event detail for the last 24 hours.  It displays both scheduled and non-scheduled 
expiration (server-initiated) events for the TSM servers in the environment. 
Expiration is a process on the TSM server that purges backup history from the 
TSM database after it has expired according to some pre-configured policies.  It is 
a critical and time-consuming component of basic TSM server administration that 
often occurs outside the daily backup window.  

■ Disk Pools - Displays the Disk Pool Volumes report that shows the disk pool 
name, volume, device class, capacity (MB), percentage utilized, status (e.g., 
online), and access (e.g., READWRITE). Disk Pools are a typical staging area for 
backup data on a TSM server.  Backups are most often written to disk (i.e. disk 
pools) and the migrated to other disk pools or tape pools.  It is common for an 
organization to keep 24 hours (and sometimes much more) worth of backup on 
disk.  In most TSM implementations, TSM administrators need to monitor the 
overall state of their disk pools.  If a volume contained within a disk pool goes 
offline, it could mean backups and/or restores may be affected.  If a disk pool fills 
completely and unexpectedly, the TSM server may begin migrating the data to 
tape, again, potentially affecting backups and restores.

■ Reclamation - Displays the Reclamation Status report showing a listing of all 
reclamation sessions that moved data from a set of fragmented tapes to a smaller 
number of tapes over the past 24 hours. Reclamation is the process of reclaiming 
empty space on tape that results from TSM expiration.  Put another way, 
reclamation is a form of eliminating fragmentation within a TSM storage pool.  In 
most TSM environments, reclamation applies primarily to tape.  When a 
reclamation process is in progress, the TSM server copies all of the unexpired data 
from a set of tapes to a new (yet smaller) set of tapes.  The result is that the same 
amount of recoverable data now resides on a smaller set of tapes and the original 
tapes are sent to the scratch pool, making them available to be written to again.

■ Reclaimable Tapes - Displays the Reclaimable Tapes report that provides a listing 
of all tapes that meet a certain reclamation threshold.  It displays not only the tape 
volume’s status but also its location. The reclamation threshold is set on the TSM 
Report Parameters window accessed under the Tools pull down menu. The 
default reclamation threshold is 65 %.

■ Suspect Tapes - Displays the Suspect Tapes report that provides a list of "suspect" 
tape volumes along with some of the data that describes the condition of each of 
the volumes. A suspect tape is any tape that is not writable or has had a read or 
write error detected at some point in time.   

■ Tape Devices - Displays the Tape Devices report showing the most recent status of 
all the tape and library drives and device paths..
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TSM Event Summary 
The TSM Event Completion Summary report is designed to allow non TSM 
administrators to view TSM events without having access to the full TSM Daily 
Administration report.  All users that have the "TSM Backup Product" option 
enabled in their current dashboard can view the status of TSM scheduled events. 
Full Sun StorageTek Business Analytics view security is implemented in the TSM 
Event Summary report.  That is, a Sun StorageTek Business Analytics administrator 
may create different views (e.g. for different business units) within the application 
just for TSM users.  After assigning individual TSM nodes to each of the views, 
different users can be assigned to a particular view.  In this way, non-TSM 
administrators can view the status of their events (and only their events).

You can navigate to the Scheduled Event Completion Summary in either of the 
following two ways:

■ The TSM Daily Administration Report has navigation hyperlink to the Event 
Completion Summary at the site level.  However, only TSM administrators have 
access to the TSM Daily Administration report where there is no view security 
applied.  TSM administrators see all TSM scheduled events for all nodes - not just 
those for a given business unit.

■ The Backup/Restore pull down menu contains a TSM Event Summary option. 
This menu option is available to all users that have "TSM enabled in their current 
dashboard.dashboard. 

TSM Reporting Wizards
The TSM Reporting Wizards allow you to create or view custom reports based on 
TSM jobs, occupancy, or media stored in the TSM-related tables in the Business 
Analytics database. The TSM reporting wizards support the aggregate functions 
previously described for the Job Report Wizard and the Media Report Wizard.

TSM Event Report Wizard
The TSM Event Report Wizard allows you to create, save, and display a custom 
report regarding the jobs/event status and success stored in the Sun StorageTek 
Business Analytics database. 
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1. Select Backup/Restore → TSM Reporting Wizards → TSM Event Wizard from the 
Home Page. 

The first page of the TSM Event Report Wizard appears. You can choose to:

■ Create a new report

■ Delete an existing report (if any exists)

■ Verify/change how a report is shared as (Global or Private) 

■ Generate a report using existing saved parameters through the Available Reports 
list box

2. Click Next>> on the TSM Event Report Wizard window and the Step 2 of 5: TSM 
Events Report Wizard - Choose Columns window. 

The Columns Available list box is a scrollable, multi-select list box that displays the 
list of columns available for inclusion and the order to display them in the final 
view. Initially, no columns appear in the Columns to Display list box. After you add 
fields to the Columns to Display list box, you can highlight a field and click the Up 
or Down arrow to move the field up or down, respectively. 

3. Add/remove columns to the new (or existing) report and click Next>>. 

The Step 3 of 5: TSM Events Report Wizard - Select Filters window appears. It allows 
you to specify rules to filter the extracted rows of data and, thereby, add constraints 
to the database query.



Chapter 5 Backup and Restore 145

FIGURE 5-24 Step 3 of 5: TSM Event Report Wizard - Select Filters

4. Click Next>> and the Step 4 of 5: TSM Events Report Wizard - Sorting window 
appears. 

Add the sort keys to the SQL Query. 

5. Click Next>> and the Step 5 of 5: TSM Events Report Wizard - Summaries 
window appears. 

Define any desired aggregate functions, such as the average (AVG) of backed up KB, 
and/or the options to display sub totals and totals for the report.
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FIGURE 5-25 Step 5 of 5: TSM Event Report Wizard - Summaries

6. Click Finish to generate the custom report based on the TSM events in the 
database. 

TSM Media Report Wizard
The TSM Media Report Wizard allows you to create, save, and display a custom 
report regarding the media used by TSM.

1. Select Backup/Restore → TSM Reporting Wizards → TSM Media Wizard from the 
Home Page. 

The first page of the TSM Media Report Wizard appears. You can choose to:

■ Create a new report

■ Delete an existing report (if any exists)

■ Verify/change how a report is shared as (Global or Private) 

■ Generate a report using existing saved parameters through the Available Reports 
list box
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2. Click Next>> on the TSM Media Report Wizard window and the Step 2 of 5: TSM 
Media Report Wizard - Choose Columns window is displayed. 

The Columns Available list box is a scrollable, multi-select list box that displays the 
list of columns available for inclusion and the order to display them in the final 
view. Initially, no columns appear in the Columns to Display list box. After you add 
fields to the Columns to Display list box, you can highlight a field and click the Up 
or Down arrow to move the field up or down, respectively. 

FIGURE 5-26 Step 2 of 5: TSM Media Report Wizard - Choose Columns

3. Add/remove columns to the new (or existing) report and click Next>> to display 
the Step 3 of 5: TSM Media Wizard - Select Filters window. 

Specify rules to filter the extracted rows of data and, thereby, add constraints to the 
database query.

4. Click Next>> and the Step 4 of 5: TSM Media Report Wizard - Sorting window 
appears. 

Add the sort keys to the SQL Query.

5. Click Next>> and the Step 5 of 5: TSM Media Report Wizard - Summaries 
window appears. 
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Define any desired aggregate functions, such as the average (AVG) percent utilized, 
and/or the options to display sub totals and totals for the report.

FIGURE 5-27 Step 5 of 5: TSM Media Report Wizard - Summaries

6. Click Finish to generate the custom TSM media report.
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FIGURE 5-28 Sample TSM Media Report Wizard

TSM Backup Occupancy Report Wizard
The TSM Backup Occupancy Report Wizard allows you to create, save, and display 
a custom report based on TSM occupancy information stored in the Business 
Analytics database.

1. Select Backup/Restore → TSM Reporting Wizards → TSM Backup Occupancy 
Wizard from the Home Page. 

The first page of the TSM Occupancy Report Wizard appears. You can choose to:

■ Create a new report

■ Delete an existing report (if any exists)

■ Verify/change how a report is shared as (Global or Private) 

■ Generate a report using existing saved parameters through the Available Reports 
list box
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2. Click Next>> on the TSM Occupancy Report Wizard window and the Step 2 of 5: 
TSM Occupancy Report Wizard - Choose Columns window appears. 

The Columns Available list box is a scrollable, multi-select list box that displays the 
list of columns available for inclusion and the order to display them in the final 
view. Initially, no columns appear in the Columns to Display list box. After you add 
fields to the Columns to Display list box, you can highlight a field and click the Up 
or Down arrow to move the field up or down, respectively. 

FIGURE 5-29 Step 2 of 5: TSM Occupancy Report Wizard - Chosoe Columns

3. Add/remove columns to the new (or existing) report and click Next>>. 

The Step 3 of 5: TSM Occupancy Report Wizard - Select Filters window appears. It 
allows you to specify rules to filter the extracted rows of data and, thereby, add 
constraints to the database query.

4. Click Next>> and the Step 4 of 5: TSM Occupancy Report Wizard - Sorting 
window appears. 

Add the sort keys to the SQL Query. and click Next>>. 

5. Click Next>> and the Step 5 of 5: TSM Occupancy Report Wizard - Summaries 
window appears. 
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Define any desired aggregate functions and/or the options to display sub totals and 
totals for the report.

6. Click Finish to generate the custom report.

Tape Libraries
A user, who is assigned "Backup Administrator" administrative rights, can access the 
following reports from the Tape Libraries menu selection in the Backup/Restore pull 
down menu:

■ Library Asset Report

■ Global Status Report

■ Library Statistics Report

■ Backup Media Search

■ Tape Drive Allocation

Library Asset Report
The Library Asset Report enables the Backup Administrator to monitor the 
utilization of tape libraries. The report is available at the site and tape library levels. 
For a selected site, you can obtain information on the drives and cells for its tape 
libraries. 

Proceed as follows:

1. Select Backup/Restore → Tape Libraries → Library Asset Report. 

2. Select a site to display the Tape Library Utilization report. 

The Tape Library Utilization report appears in the report pane.
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FIGURE 5-30 Library Asset Report

Tape library utilization shows the library name, library type, number of free cells, 
number of active cells, total cells, and percentage of cells utilized. Clicking on the 
Library Name link displays the tabular device report, Detailed Library 
Configuration, for the selected tape library. Refer to Chapter 2 for a description of 
the tabular device report, Detailed Library Configuration.

3. Optionally use the Calendar function to select a date or accept the default value of 
the current date. 

4. Expand a site in the navigation pane and view a list of all tape libraries contained 
at that site. 

5. Click on a tape library in the navigation pane to view the tabular device report, 
Detailed Library Configuration View, for that tape library. 

Global Status Report
The Global Status Report provides the Backup Administrator general library and 
CAP status information. The report is available at the enterprise and site levels. 
Proceed as follows:

1. Select Backup/Restore → Tape Libraries → Global Status Report and the Global 
Status Report appears.
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2. Click enterprise or the desired site in the navigation pane and the Library Status 
View Report appears in the center pane.

FIGURE 5-31 Global Status Report

For each tape library, the library status, drive status, and cap status appear. The 
Library link displays the Library Configuration View.

The Library Configuration View contains a utilization pie chart, a trending line 
graph, and the library’s hardware/software configuration in tabular format.
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FIGURE 5-32 Library Configuration View

The trending information covers the last three months, such as the above report’s 
date range of 6/2/2004 through 9/2/2004 where the report was generated on 
9/2/2004. 

Clicking the Cell Information button displays the Cell Information report. For the 
library, it shows the Cell ID, Label, and Media Type. The Label link displays the 
Backup Media Details report. This detailed report shows the media capacity, status, 
number of backup images, number of restores, its volume pool, when it was last 
read, mounted, and written. It also allows the administrator to see how much data 
(MB) has been written and whether or not the media is full. Sun StorageTek Business 
Analytics obtains this information if it is available from the backup application.

If the agent is successfully communicating with the tape library, the status is 
indicated as "Okay" and the status box is green. If the agent is not successfully 
communicating with the tape library, the status is indicated as "Unknown" and the 
status box is yellow. An error status is flagged using a status box of red. Clicking on 
a component with an error status displays a more detailed component report. For 
example, clicking on a drive status of "Degraded" displays the Drive Status View, 
shown below.
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FIGURE 5-33 Drive Status View

The backup administrator can view the drive model, vendor, serial number, and 
firmware revision to more expediently address the problem. 

Clicking the Degraded link displays the Drive Status Detail report that lists any 
available events in the Events table. The Events table shows the event ID, source, 
description, and time.

Library Statistics Report
The Library Statistics Report provides library usage statistics that include the 
number of initializations, exchange rate per hour and total number, the percentage of 
target reads that were successful, and the number of retries for a selected site.

For a site, the report contains the library name, number of initializations, exchange 
rate/hour, total number of exchanges, the percentage of target reads that were 
successful, and the number of retries for target reads. The Library Name link 
displays the Library Configuration Report.

If a specific tape library is selected, the Library Statistics Report header provides the 
site name, library name, and Calendar functions to set a start date and time and an 
end date and time. 

Clicking the Drives button displays the Library Drive Statistics report. It shows the 
Drive ID, number of mounts, number of mount retries, the number of dismounts, 
and the number of dismount retries.
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The report provides the following line graphs:

■ Library Activity - Shows resets, moves, door opens, and empty reads

■ Mounts and Dismounts - Shows mounts and dismounts

■ Label Reads - Shows retries, failures, and successful reads

■ Target Reads - Shows retries, failures, and successful reads

■ Media Retrieval Activity - Shows retries, failures, and retrievals

■ Media Insertion Activity - Shows, retries, failures, and insertions

■ Enters and Ejects - Shows enters and ejects

For planning purposes, a Trending button is located beside each line graph in the 
report. Trending data is based on the collection of statistics on a daily basis over the 
past thirty days.

Backup Media Search
The Backup Media Search report is allows you to locate tape media tracked in the 
database by entering one of the following search strings:

■ Tape label

■ Backup client

■ Backup server

FIGURE 5-34 Backup Media Search
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The Backup Media Search report is currently available for the Veritas NetBackup 
(not Legato NetWorker) backup application.

The Backup Media Search report allows you to locate tape media by entering a tape 
label as a search string, entering a backup client as a search string, or by entering a 
backup server as a search string.

FIGURE 5-35 Backup Media Search

After you specify your search criteria, click Refresh Report. If the media is located, 
the report will display the Backup Media Location table, similar to the one shown 
below.
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FIGURE 5-36 Backup Media Location

The table shows the site, how long the media has been in the library, and the media 
type. Clicking on the Backup Media Link displays the Backup Media Details report, 
similar to the one shown below.

Clicking the Backup Clients using Media link displays the backup client name, the 
master server, and the media ID.

Clicking the Backup Media Detail link displays the Backup Media Detail report, 
similar to the one that follows.
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FIGURE 5-37 Backup Media Details

This detailed report shows the media capacity, status, number of backup images, 
number of restores, its volume pool, when it was last read, mounted, and written. It 
also allows the administrator to see how much data (MB) has been written and 
whether or not the media is full. Sun StorageTek Business Analytics obtains this 
information if provided by the backup application.

Tape Drive Allocation
Tape Drive Allocation provides two reports:

■ Daily Tape Drive Allocation Summary - Shows for a particular library a 
summarized (count by status) during a twenty-four hour interval.

■ Daily Tape Drive Allocation Detail - Shows the status for each drive installed in 
the library during a 24-hour day.

You only see tape libraries (assets) for which you have authorization through your 
view.
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1. Select Backup/Restore → Tape Libraries → Tape Drive Allocation and the Tape 
Drive Allocation report main window appears. 

2. Expand the desired site in the navigation pane and the tape libraries are listed.

3. Click on the icon for the desired tape library and the Daily Tape Drive Allocation 
Summary report is displayed.

The report header identifies the site name, location, report interval, and total number 
of drives installed in the library at the specified time. The Library Name is a report 
link to the Library Configuration report.   

The Control Pane includes an integer input box labeled "Interval” hr(s)". The number 
that you enter in this input box controls the granularity of the data in the table. For 
example, if the interval is 4 hours, the table will display six (6) rows for a 24 hour 
period. The default value of interval is 1 hour. 

As indicated in the navigation pane, time is in GMT format. The navigation pane 
allows you to change the default start date/time and end date/time. The default 
value is the previous 24-hour day but it can be less than twenty-four (24) hours.

The Drive Status Summary by Hour area chart is generated using the collection 
interval defined by the agent. By default, this interval is 15 minutes. The table 
beneath the area chart shows the data that was used to produce the chart. The drive 
status is calculated in increments of fifteen (15) minutes. If there are number of 
changes in an hour then, in only the latest status of drives in the given duration will 
be seen. 

4. To display detail-level tape library allocation report, click the Show Detailed 
Report link above the area chart. 
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FIGURE 5-38 Daily Tape Drive Allocation Detail

The report header identifies the site name, location, report interval, and total number 
of drives installed in the library at the specified time. In the heading, the Library 
Name is a report link to the Library Configuration report. Clicking the Change to 
Summary report link displays the Daily Tape Drive Allocation Summary report.
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CHAPTER 6

Servers

This chapter describes the different reports available through the Management 
Console’s Servers pull down menu. The following topics are discussed:

■ “HBA Configuration” on page 163

■ “OS Type” on page 165

■ “Server Trending and Forecasting” on page 166

■ “Server Storage and Utilization” on page 155

■ “Filesystem Utilization” on page 171

■ “Filesystem Consumers” on page 173

■ “Filesystem Age” on page 174

■ “Filesystem Age: % Accessed Report” on page 175

■ “Filesystem Level Details” on page 176

■ “Filesystem Age: % Modified Report” on page 178

■ “Filesystem Age: % Created Report” on page 179

■ “File-Level Wizard” on page 179

■ “Host Filesystem Report Wizard” on page 184

■ “Server Report Wizard” on page 187

■ “Host HBA Report Wizard” on page 190

■ “Disks Report Wizard” on page 192

HBA Configuration
The HBA Configuration report displays the vendor model, WWN, IP address, node 
name and driver revision level of each Host Bus Adapter (HBA); it also summarizes 
this information by enterprise or site. 
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HBA configuration details are presented in a pie chart, which shows the amount and 
percentage of HBAs by vendor. The table beneath the pie chart contains the 
following information:

■ Node Name

■ World Wide Name (WWN) for the Adapter

■ IP Address of Host

■ Vendor Model of the Adapter

■ Driver Revision of Microcode

■ Operating System

Proceed as follows:

1. Select Servers from the Home Page.

2. Select HBA Configuration and the HBA Configuration main window is displayed.

3. In the upper left section of the menu control tree, use the Sort By radio box to set 
the report to be generated by Site or by Vendor.

4. Use the Calendar function to set the start date.

5. Click on a view or site to generate a report for the enterprise or selected site, 
respectively.

FIGURE 6-1 HBA Configuration: Vendor Usage
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Clicking the WWPN link displays the HBA Details report, similar to the one shown 
in FIGURE 6-2.

FIGURE 6-2 HBA Detail

OS Type
The OS Type report shows you the operating system of each server, and the 
percentage of operating system types by site. At the level of the individual server, it 
shows you the node name, the IP address, and the kernel patch level.

Clicking a Site will expand the listing to show the different operating systems 
deployed at that site. Clicking an Operating System will produce a report detailing 
each system running the selected operating system type.
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FIGURE 6-3 OS Usage at Site

Server Trending and Forecasting
The Server Trending and Forecasting report allows you to determine the filesystem 
utilization patterns for organization. The report is available at the view, site, server, 
and filesystem levels.

The navigation pane provides options as follows:

■ Trending - The Trending option allows you to analyze historical consumption for 
a file-system, server, site, or the entire enterprise. This option only looks at past 
consumption. 

■ Forecasting - The Forecasting option allows you to project future file-system 
requirements based upon past usage and planned projects. Use this report to 
determine when you will need to allocate additional storage to the server. 

■ Date Range - These fields indicate the date range that the report should use to 
calculate the forecast. If the range is less than a month long, the report will use a 
value from the end of each day to calculate the forecast. If the range is between 1 
and 6 months, the report will use a value from the end of each week to calculate 
the forecast. If the range is longer than 6 months, the report will use a value from 
the end of each month to calculate the forecast. 

■ Forecast Period - Enter how far into the future you would like the report to 
forecast. 
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■ Targeted Maximum Consumption - If you wish to maintain a reserve of space, 
indicate the amount as a percentage of your total. In other words, if you wish to 
manage your file-system to 90% maximum usage (and maintain a 10% reserve), 
then enter 90% into this field. The report will indicate the date when you can 
anticipate running out of space based on historical usage. 

Server Storage Utilization 
The Server Storage Utilization report helps to identify storage that is available to the 
server but has not been used for a file system or logical volume. This report is only 
concerned with allocated storage that is presented to the server as usable storage; it 
does not include RAID overhead such as remote or local copies.

The report is available to any user that has access to the Servers menu according to 
their current security settings. The user’s current view controls the assets that are 
displayed in the report.
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1. Select Servers -> Server Storage Utilization and the Server Storage Utilization 
window is displayed.

The window contains a control pane, a navigation pane, and a report pane. The 
control pane provides the Calendar function to allow you to set the start date for 
data extraction. The navigation pane uses a hierarchy of view, site, and server. The 
report pane does not contain data when it is initially opened. Instead, the report 
contains the following description:

“The Allocated Storage vs. Server Usage report shows how the storage (both local 
and remote) available to each server is used. The goal is to identify storage that is 
available to the server but has not been used for a file system or logical volume. The 
figures for SAN storage represent Usable Storage as allocated to the server (i.e., they 
do not include RAID overhead). 

The report includes the following columns 

Local Devices (GB) - Total of all data volumes (standard and remote primary) 
allocated to a server. 

SAN Attached (GB) - The total of all physical devices (both local and remote) that 
are available on the server. 

LVM - If Host LVM is present on the host column indicates 'Y', if LVM is not present 
'N' 

Logical Capacity (GB) - Total of all logical disks defined within the Logical Volume 
Manager (LVM). If LVM is not installed PARTITIONS will be considered. 

Logical Capacity Type - Indicates weather Logical capacity is of type 
LDISK/PARTITION 

Unused Devices Space (GB) - Computed as (Total Devices Capacity (Remote+Local) 
- Logical Capacity). Represents capacity that is available to the server, but is not 
being used by the Volume Manager. Note: This storage may be used by an 
application that uses raw physical devices, such as a database, or may be under the 
control of the operating system's native file system. 

LVM/PARTITION Raw (GB) - The total size, in raw terms of all Logical Volumes 
defined on the server. 

Usable Capacity (GB) - The total size in usable space of all logical volumes defined 
on the server. IF LVM is not installed PARTITIONS will be considered 

Unused LVM/PARTITION Space (GB) - Computed as (Logical Capacity - 
LVM/PARTITION Raw GB). Represents space that is available to the LVM but has 
not been used in any logical volumes. This space is available for use on the server. 

LVM RAID Overhead (GB) - Computed as (LVOL/PARTITION Raw GB - Usable 
Capacity). Represents the overhead represented by RAID protection in the Logical 
Volume Manager. Useful for identifying cases where you have added RAID 
protection in the LVM to storage which already has RAID protection on the array. 

File System Usable (GB) - The total amount of file system space visible to users. On 
a Unix server, this does not include the 10% typical overhead that is available only to 
the administrator account. 
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Unused LVOL/PARTITION (GB): Computed as (Logical Capacity Usable - File 
System Usable). Represents space that is available in logical volumes, but not used 
for a file system. This space is available for use on the server. Note: This storage may 
be used by an application that uses raw physical devices, such as a database.”

2. Use the Calendar function in the control pane to set the desired date. 

This sets the start date for the SQL query used to extract the data.

3. To generate the Server Storage Utilization report for an asset, click a site or 
expand a site and select a particular server in the navigation pane. 

The report pane includes a header area with the report title, enterprise name, and the 
report level as selected from the navigation tree. The report header also shows the 
date of the report. 

Clicking on a header in the table will update the current sort order. The table 
provides the following columns:

■ Host Name - Server name.

■ Local Devices (GB) - Total of all local physical devices.  

■ SAN Allocated (GB) - Total of all physical devices which are remote, these are 
Host perspective remote devices. 

■ LVM - Displays 'Y' if Logical Volume Manager (LVM) is installed on the host, 'N' 
if LVM is not present. 

■ Logical Capacity (GB) - Total of all logical disks defined within the LVM. If LVM 
is not installed PARTITIONS will be considered. 

■ Logical Disk Type - Indicates whether Logical Capacity consists of 
LDISK/PARTITION. 

■ Unused Device Space (GB) - Computed as (Physical Devices – Logical Capacity). 
Represents capacity that is available to the server, but is not being used by the 
Volume Manager. Note that this storage may be used by an application that uses 
raw physical devices, such as a database, or may be under the control of the 
operating system's native file system. 

■ LVM/PARTITION Raw Capacity (GB) - The total size, in raw terms of all Logical 
Volumes defined on the server. 

■ Unused Logical Capacity (GB) - Computed as (Logical Capacity - 
LVM/PARTITION Raw Capacity) 

■ Usable Capacity (GB) - The total size in usable space of all logical volumes 
defined on the server. 

■ Unused LVM/PARTITION Space (GB) - Computed as (Logical Capacity – Logical 
Capacity Raw) . Represents space that is available to the LVM but has not been 
used in any logical volumes. This space is available for use on the server. 
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■ LVM RAID Overhead (GB) - Computed as (Logical Capacity Raw – Logical 
Capacity Usable). Shows the overhead represented by RAID protection in the 
Logical Volume Manager. Useful for identifying cases where you have added 
RAID protection in the LVM to storage which already has RAID protection on the 
array. 

■ File System Usable (GB) - The total amount of file system space visible to users. 
On a Unix server, this does not include the 10% typical overhead that is available 
only to the administrator account.This calculation is based on filesystems that are 
under LVM control. Filesystems outside LVM control are ignored. 

■ Unused LVOL/PARTITION (GB) - Computed as (Usable Capacity – File System 
Usable). Represents space that is available in logical volumes, but not used for a 
file system. This space is available for use on the server. Note that this space may 
be used by an application that uses raw physical devices, such as a database. 

A sample report at the server level is shown below.

FIGURE 6-4 Server Storage Utilization
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Filesystem Utilization
To assist in activities like backup planning and storage provisioning, the Filesystem 
Utilization report provides the Sun StorageTek Business Analytics administrator 
insight into the distribution of files and their relative sizes across the various file 
systems. 

The information for each file system includes:

■ Host name

■ File system name

■ Type (e.g., NTFS)

■ Total size (MB)

■ Used size (MB)

■ Percentage used (numerical and bar graph formats)

If a particular drive is configured as raw storage for a database, it is interpreted as 
100% utilized within the filesystem utilization reports. The control pane provides the 
"Suppress Filesystems with 100% utilization check box. Putting a check mark in the 
check box allows you to suppress drives that are reported as 100% utilized.

The navigation pane allows you to:

■ Select a sort order of either by site or by OS 

■ Use the Calendar function to refresh data to a desired date

A sample filesystem listing is shown in FIGURE 6-5.
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FIGURE 6-5 Filesystem Listing

Note: In general, the file system reports provide a set of buttons at the bottom of the 
screen that allow you to navigate forwards (>), backwards (<), to a particular page, 
to the first page (|<), or to the last page (>|) of a report. Click Show All to display 
all the details without pagination.

Clicking the Host Name link displays the Detailed Host Configuration and 
Utilization tabular report for the selected host server.  Refer to Chapter 2 to obtain 
information on this tabular report.
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FIGURE 6-6 Detailed Host Configuration and Utilization

Filesystem Consumers
This report illustrates the amount of storage capacity used by particular hosts. The 
navigation pane allows you to select the enterprise, site, or host server. 

The report pane provides the following information:

■ Host Name

■ Consumer Name (file system owner)

■ Group Name

■ Consumed Space (MB)

Use the Calendar function to display a report for a date other than the current date. 
Clicking the Host Name link displays the Detailed Host Configuration and 
Utilization report. Refer to the previous Host Configuration section for additional 
information on the Detailed Host Configuration and Utilization report.

A sample Filesystem Consumers report is shown in FIGURE 6-7.
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FIGURE 6-7 File System Consumers - Server Level

Clicking the plus sign (+) allows you to browse the various servers at a site. 
Choosing a server displays the capacity usage, shown in FIGURE 6-7, for the selected 
host server.

Filesystem Age
The File System Age menu selection provides access to three reports:

■ File System Age:% Accessed

■ File System Age: %Modified

■ File System Age: %Created

■ Wizard
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Note – If a particular drive is configured as raw storage for a database, it is 
interpreted as 100% utilized within the File System Age reports. The control pane of 
these reports provides the "Suppress Filesystems with 100% utilization check box. 
Putting a check mark in the check box allows you to suppress drives that are 
reported as 100% utilized in these reports.

Filesystem Age: % Accessed Report
This report helps the Sun StorageTek Business Analytics administrator to determine 
obsolete files that are candidates for deletion on a selected host server.  The 
navigation pane allows you to select the desired aging factor of one hour, one day, 
seven days, one month, three months, one year, or seven years. Clicking an age 
factor (e.g., 1 day) displays the Filesystems: Accessed report for all sites. It identifies 
the site (by ID), the host server name, the file system name, the Total Size (MB), the 
Used Size (MB), the Size Accessed (MB), and the percentage % Accessed.  

FIGURE 6-8 Sample Filesystem Accessed Report

You can expand an aging factor in the navigation pane and click a particular site to 
generate the site-level Filesystems: Accessed report.  
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Choosing a particular site displays the report at the site level. Choosing a particular 
host server displays the Filesystems: Accessed report for the selected server in the 
center pane. 

You can use the toolbar at the bottom of the screen in some reports to navigate 
through the reports. Various tool bar buttons are enabled or disabled depending on 
what view level is current. The Navigation Toolbar is shown below.

TABLE 6-1 describes the navigational controls.

Filesystem Level Details
Choosing a particular Filesystem Name in any of the Filesystem Age reports will 
display the Filesystem Level Details report in the center pane.

TABLE 6-1 Navigational Toolbar for Filesystem Reports

Control Function

Left stop Go to the first page

Left arrow Go to the previous page

Jump to Page Go to the page specified

Right arrow Go to the next page

Right stop Go to the last page

Show All Show entries without pagination

ShowPagination Show entries with pagination
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FIGURE 6-9 Filesystem Level Details

The navigation pane allows you to select Summary Information, Share, Directories, 
Distribution of Files, or Specific Files reports. 

■ Summary Information - Shows the file system usage, file system growth, and file 
system details (e.g., number of files).

■ Share - Lists the share name, the share type, the share path, the filesystem name, 
and options.

■ Space Consumers - Identifies the user name, the group name, and the consumed 
space (MB) for various filesystem consumers 

Expanding the Directories heading allows you to view the top five configured 
directories by usage in a pie chart. In addition to the directories specifically 
configured for scanning and reporting, the bar chart summarizes space usage by 
other directories. Beneath the pie chart, the table identifies the directory name, the 
owner, the space used (MB) and the percentage of space used.

Expanding the Distribution of Files heading allows you to select generating the 
report by file type or file size. Specific Files provides access to reports on largest 
files, largest old files, email archive, and any user-defined, specific file types defined 
in the SRM Agent Configuration File.
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The pie charts in the center pane show file system utilization and space used in MB. 
This data appears in tabular format beneath the pie charts.

Filesystem Age: % Modified Report
This report can also help the Sun StorageTek Business Analytics administrator to 
determine obsolete files that are candidates for deletion on a selected host server.  
The navigation pane allows you to select the desired aging factor of one hour, one 
day, seven days, one month, three months, one year, or seven years.

You can select an aging factor and then click a site in the navigation pane to display 
a site-level report.  

FIGURE 6-10 Filesystem Age: % Modified

The site, host name, file system name, total space, used space, sized modified, and 
percentage modified appears for each file system.
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Filesystem Age: % Created Report
This report also helps the Sun StorageTek Business Analytics administrator to 
determine to what extent storage capacity is utilized via the creation of new file 
systems. This information can help to provision storage as necessary to 
accommodate growth and to configure backup policies to handle new file systems.

The navigation pane allows you to select the desired aging factor of one hour, one 
day, seven days, one month, three months, one year, or seven years. 

You can select an aging factor and then click a site in the navigation pane to display 
a site-level report.  

FIGURE 6-11 Sample Filesystem Age: % Created Report

File-Level Wizard
The File-Level Wizard allows you to generate and save personal reports.  It provides 
the following standard capabilities: 

■ Select fields (from a pre-defined list)

■ Enter conditions (or filters) that control what data records are displayed

■ Determine the order in which records displayed

■ Choose aggregate functions to provide summarization information for the SQL 
statement, such as counts, totals, and averages
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■ Use the above conditions to generate a report that can be printed and/or saved 
for future use

■ Export data to standard formats (ASCII, Excel, .XML)

The Reporting Wizards include a “Summaries” window that allows you to include 
aggregate functions in the generated report. Functions are keywords in SQL used to 
manipulate values within columns for output purposes. A function is a command 
always used in conjunction with a column name or expression. An aggregate 
function provides summarization information for an SQL statement, such as counts, 
totals, and averages. 

This facility allows you to create custom reports with groupings of data like the 
average (AVG) of total capacity used in the File System Report Wizard or maximum 
(MAX) and minimum (MIN) of capacity in the Disk Report Wizard.

Proceed as follows:

1. Select Servers → Reporting Wizards → File-Level Wizard. 

The Step 1 of 5: SRM Files Wizard window is displayed. The default option is to 
create a new report by clicking Next>> to continue. You can select a report from the 
Available Reports dropdown list, click Finish>> to execute report without changing 
parameters, or select a report and Click the Delete>> button to delete a saved report.

2. After you create Next>>, the Step 2 of 5: SRM Files Wizard - Choose Columns 
window is displayed.
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FIGURE 6-12 Step 2 of 5: SRM Files Wizard - Choose Columns

3. All columns that can be selected for the report are displayed in the Columns 
Available list box.  

Column names must be in right panel to display. To select the columns for your 
report, use the Add>>, Remove>>, Add All>>, and Remove All>> control buttons to 
add/remove columns to/from the Columns to Display list box. The default 
maximum number of rows to be displayed is 300.  This can be changed for an 
individual execution of report, but is not saved. You can select a Column Name and 
press one of the blue arrows to move it up or down in the list.  This is the order in 
which they will display (left to right) in the resulting report. "Exclude duplicate 
records" is enabled by default.   

4. After you select the columns and click Next>>, the Step 3 of 5: SRM Files Wizard 
- Select Filters window is displayed.
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FIGURE 6-13 Step 3 of 5: SRM Files Wizard - Select Filters

5. Set optionally any desired record selection criteria for the SQL query that is used 
to extract data for the report. 

To do so, use the Field, Operator and Value parameters. You can enter a relative date, 
where the syntax is "Today-n" and n sets the number of days.  For example, "Today - 
60" will deliver all files that have not been accessed in the past 60 days. 

6. After you select filters and click Next>>, the Step 4 of 5: SRM Files Wizard - 
Sorting window is displayed. 

The columns you add to the Sort Keys list box determine the sort order for the 
report. 

7. After you define the sort order, click Next>>.

The Step 5 of 5: SRM Files Wizard - Summaries window is displayed. Specify any 
desired aggregate functions and/or how sub totals and totals will be handled.
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FIGURE 6-14 Step 5 of 5: SRM Files Wizard - Summaries

8. Click Finish to generate and display the custom report.

To save a report, enter a report name, and then press the Save Report button. 

The Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button.
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FIGURE 6-15 Sample SRM Files Wizard Report

Host Filesystem Report Wizard
The Host Filesystem Report Wizard allows you to create custom reports using the 
host filesystem table. You specify a list of data columns, filters, and sorting criteria 
when you use the wizard. You can optionally choose aggregate functions to provide 
summarization information for the SQL statement, such as counts, totals, and 
averages

The wizard may have the following buttons enabled:

■ Delete - Delete a specified existing report. 

■ Back - Return to previous template window.

■ Next - Go to next step in the process.

■ Finish - Skip the remaining steps and display the report based on the current 
query criteria.

■ Cancel - Abort the procedure and exit.

Proceed as follows:
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1. Select Servers from the Home Page. 

2. Select Reporting Wizards → Filesystem Wizard. 

The Step 1 of 5:  Host Filesystem Report Wizard window appears. The default option 
is to create a new report by clicking Next>> to continue. You can select a report from 
the Available Reports dropdown list, click Finish>> to execute report without 
changing parameters, or select a report and Click the Delete>> button to delete a 
saved report.

3. After you click Next>> to create a new report, the Step 2 of 5: Host Filesystem 
Report Wizard - Choose Columns window is displayed.
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FIGURE 6-16 Step 2 of 5: Host Filesystem Report Wizard - Choose Columns 

4. All columns that can be selected for the report are displayed in the Columns 
Available list box.  

Column names must be in right panel to display. To select the columns for your 
report, use the Add>>, Remove>>, Add All>>, and Remove All>> control buttons to 
add/remove columns to/from the Columns to Display list box. The default 
maximum number of rows to be displayed is 300.  This can be changed for an 
individual execution of report, but is not saved. You can select a Column Name and 
press one of the blue arrows to move it up or down in the list.  This is the order in 
which they will display (left to right) in the resulting report. "Exclude duplicate 
records" is enabled by default.   

5. After you select the columns and click Next>>, the Step 3 of 5: Host Filesystem 
Report Wizard - Select Filters   window is displayed.

6. Set optionally any desired record selection criteria for the SQL query that is used 
to extract data for the report. To do so, use the Field, Operator and Value 
parameters. 
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7. After you select filters and click Next>>, the Step 4 of 5: Host Filesystem Report 
Wizard - Sorting window is displayed. 

The columns you add to the Sort Keys list box determine the sort order for the 
report. 

8. After you define the sort order, click Next>>.

The Step 5 of 5: Host Filesystem Report Wizard - Summaries window is displayed. 
Specify any desired aggregate functions and/or how sub totals and totals will be 
handled.

9. Click Finish to generate and display the customized report. 

To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button. 

Server Report Wizard
The Server Report Wizard allows you to create custom reports based on information 
stored in the host configuration table. You specify a list of data columns, filters, and 
sorting criteria when you use the wizard. You can optionally choose aggregate 
functions to provide summarization information for the SQL statement, such as 
counts, totals, and averages

The wizard may have the following buttons enabled:

■ Delete - Delete a specified existing report. 

■ Back - Return to previous template window.

■ Next - Go to next step in the process.

■ Finish - Skip the remaining steps and display the report based on the current 
query criteria.

■ Cancel - Abort the procedure and exit.

Proceed as follows:

1. Select Servers from the Home Page. 

2. Select Reporting Wizards → Server Wizard. 

The Step 1 of 4:  Server Report Wizard appears. The default option is to create a new 
report by clicking Next>> to continue. You can select a report from the Available 
Reports dropdown list, click Finish>> to execute report without changing 
parameters, or select a report and Click the Delete>> button to delete a saved report.
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3. After you click Next>> to create a new report, the Step 2 of 5: Server Report 
Wizard - Choose Columns window is displayed.

FIGURE 6-17 Step 2 of 5: Server Report Wizard - Choose Columns 

4. All columns that can be selected for the report are displayed in the Columns 
Available list box.  

Column names must be in right panel to display. To select the columns for your 
report, use the Add>>, Remove>>, Add All>>, and Remove All>> control buttons to 
add/remove columns to/from the Columns to Display list box. The default 
maximum number of rows to be displayed is 300.  This can be changed for an 
individual execution of report, but is not saved. You can select a Column Name and 
press one of the blue arrows to move it up or down in the list.  This is the order in 
which they will display (left to right) in the resulting report. "Exclude duplicate 
records" is enabled by default.   

5. After you select the columns and click Next>>, the Step 3 of 5: Server Report 
Wizard - Select Filters window is displayed.
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FIGURE 6-18 Step 3 of 5: Server Report Wizard - Select Filters

6. Set optionally any desired record selection criteria for the SQL query that is used 
to extract data for the report. 

To do so, use the Field, Operator and Value parameters. 

7. After you select filters and click Next>>, the Step 4 of 5: Server Report Wizard - 
Sorting window is displayed. 

The columns you add to the Sort Keys list box determine the sort order for the 
report. 

8. After you define the sort order, click Next>>.

The Step 5 of 5: Server Report Wizard - Summaries window is displayed. Specify any 
desired aggregate functions and/or how sub totals and totals will be handled.

9. Click Finish to generate and display the customized report. 
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To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button. 

Host HBA Report Wizard
The Host HBA Report Wizard allows you to create custom reports based on 
information stored in the host bus adapter table. You specify a list of data columns, 
filters, and sorting criteria when you use the wizard. You can optionally choose 
aggregate functions to provide summarization information for the SQL statement, 
such as counts, totals, and averages

The wizard may have the following buttons enabled:

■ Delete - Delete a specified existing report. 

■ Back - Return to previous template window.

■ Next - Go to next step in the process.

■ Finish - Skip the remaining steps and display the report based on the current 
query criteria.

■ Cancel - Abort the procedure and exit.

Proceed as follows:

1. Select Servers from the Home Page. 

2. Select Reporting Wizards → HBA Wizard. The Step 1 of 5:  Host HBA Report 
Wizard window appears. 

The default option is to create a new report by clicking Next>> to continue. You can 
select a report from the Available Reports dropdown list, click Finish>> to execute 
report without changing parameters, or select a report and Click the Delete>> button 
to delete a saved report.

3. After you click Next>> to create a new report, the Step 2 of 5: Host HBA Report 
Wizard - Choose Columns window is displayed.

4. All columns that can be selected for the report are displayed in the Columns 
Available list box.  

Column names must be in right panel to display. To select the columns for your 
report, use the Add>>, Remove>>, Add All>>, and Remove All>> control buttons to 
add/remove columns to/from the Columns to Display list box. The default 
maximum number of rows to be displayed is 300.  This can be changed for an 
individual execution of report, but is not saved. You can select a Column Name and 
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press one of the blue arrows to move it up or down in the list.  This is the order in 
which they will display (left to right) in the resulting report. "Exclude duplicate 
records" is enabled by default.   

5. After you select the columns and click Next>>, the Step 3 of 5: Host HBA Report 
Wizard - Select Filters   window is displayed.

6. Set optionally any desired record selection criteria for the SQL query that is used 
to extract data for the report. To do so, use the Field, Operator and Value 
parameters. 

7. After you select filters and click Next>>, the Step 4 of 5: Host HBA Report Wizard 
- Sorting window is displayed. 

The columns you add to the Sort Keys list box determine the sort order for the 
report. 

8. After you define the sort order, click Next>>.

The Step 5 of 5: HBA Report Wizard - Summaries window is displayed. Specify any 
desired aggregate functions and/or how sub totals and totals will be handled.

9. Click Finish to generate and dispaly the customized report. 

To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button.

To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button.
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FIGURE 6-19 HBA Wizard Report

Disks Report Wizard
The Disks Report Wizard allows you to create custom reports based on information 
stored in the host physical volume tables. You specify a list of data columns, filters, 
and sorting criteria when you use the wizard. You can optionally choose aggregate 
functions to provide summarization information for the SQL statement, such as 
counts, totals, and averages.

The wizard may have the following buttons enabled:

■ Delete - Delete a specified existing report. 

■ Back - Return to previous template window.

■ Next - Go to next step in the process.

■ Finish - Skip the remaining steps and display the report based on the current 
query criteria.
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■ Cancel - Abort the procedure and exit.

Proceed as follows:

1. Select Servers from the Home Page. 

2. Select Reporting Wizards → Disks Wizard. The Step 1 of 5:  Disk Report Wizard 
window appears. 

The default option is to create a new report by clicking Next>> to continue. You can 
select a report from the Available Reports dropdown list, click Finish>> to execute 
report without changing parameters, or select a report and Click the Delete>> button 
to delete a saved report.

3. After you click Next>> to create a new report, the Step 2 of 5: Disk Report Wizard 
- Choose Columns window is displayed.

FIGURE 6-20 Step 2 of 5: Disk Report Wizard - Choose Columns 
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4. All columns that can be selected for the report are displayed in the Columns 
Available list box.  

Column names must be in right panel to display. To select the columns for your 
report, use the Add>>, Remove>>, Add All>>, and Remove All>> control buttons to 
add/remove columns to/from the Columns to Display list box. The default 
maximum number of rows to be displayed is 300.  This can be changed for an 
individual execution of report, but is not saved. You can select a Column Name and 
press one of the blue arrows to move it up or down in the list.  This is the order in 
which they will display (left to right) in the resulting report. "Exclude duplicate 
records" is enabled by default.   

5. After you select the columns and click Next>>, the Step 3 of 5: Disk Report 
Wizard - Select Filters window is displayed.

6. Set optionally any desired record selection criteria for the SQL query that is used 
to extract data for the report. 

To do so, use the Field, Operator and Value parameters. 

7. After you select filters and click Next>>, the Step 4 of 5: Disk Report Wizard - 
Sorting window is displayed. 

The columns you add to the Sort Keys list box determine the sort order for the 
report. 

8. After you define the sort order, click Next>>.

The Step 5 of 5: Disk Report Wizard - Summaries window is displayed. Specify any 
desired aggregate functions and/or how sub totals and totals will be handled.

9. Click Finish to generate and displayy the customized report. 

To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button.

To save a report, enter a report name, and then press the Save Report button. The 
Available Reports list box will allow you to generate previously saved wizard 
reports.

To export the data, first select an export format and click the Export button.
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CHAPTER 7

Databases

This chapter describes the different reports available through the Management 
Console’s Databases pull down menu.

Database Configuration and Capacity
The report is provided at the site and database server level. To access the report, 
proceed as described below.

1. Click Database Configuration/Capacity on the pull-down menu. 

2. On the Change Parameters screen, specify the date range to generate the report 
and click Generate Report.

The DB Agent View screen appears. The menu control tree lists the top-level site. 
You must click the plus sign (+) to expand to the site and database server level. At 
the Site level, the table shows the database servers that the Database agent manages 
at a particular site. 

3. Click the desired Site in the menu control tree to view the site-level report, similar 
to the one shown in FIGURE 7-1.
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FIGURE 7-1 Database Server Listing

For the selected site, you can view the database server name, type (e.g., SQL server), 
software version, IP address of the installed Database Agent, instance port number, 
date and time last polled, and the Local Manager ID. 

4. Clicking a listed Server link in the menu control tree or clicking the Server report 
link in the Database Server Listing report displays the Database Server Detail 
report, which is a detailed report for that database server. 

This report provides three tables: Database Server Overview, Databases, and 
Physical Storage Units.

■ The Database Server Overview table at the top of the report lists the type (e.g., 
SQL server), software version, IP address of the installed Database Agent, port 
number, date and time last polled, and the Local Manager ID for the selected 
database server.

■ The Databases table shows the database server name, the owner, the number of 
tables and views, the number of indices, and the number of users. 

■ The Physical Storage Units table provides information on the physical disks that 
accommodate the transaction logs and data. This section of the report shows the 
unit name, unit type, physical name, physical type (file), used space (KB), total 
space (KB), and percentage of the total space utilized by that unit type (e.g., log 
file), auto increment, and auto increment maximum limit.
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FIGURE 7-2 Database Server Detail

Note – Because of a Database Agent CLI/API restriction, the Database Agent for 
IBM DB2 does not currently report on used storage for the following storage 
elements of the DB2 database server:
• Container (file, directory)
• System Managed Storage (SMS)

As a result, the Database Configuration/Capacity report in the Management Console 
shows the utilization for System Managed Storage, Database Managed Storage, and 
SMS tablespaces as 100% utilized. However, the Database Managed Storage 
tablespace utilization is correctly reported in this report. 
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CHAPTER 8

Provisioning

This chapter describes the different reports available through the Management 
Console’s Provisioning pull down menu on the home page. You must be assigned 
the additional administrative right of GSM Provisioning Menu in your user profile 
to access and use the GSM Provisioning menus. The following topics are discussed:

■ “Introduction to Provisioning” on page 199

■ “Storage Provisioning Wizard” on page 199

■ “Provision Storage - Create New Request” on page 200

■ “Provision Storage - Copy Existing Storage Reservation” on page 208

■ “Provision Storage and Connectivity” on page 214

■ “Storage Reservations” on page 221

Introduction to Provisioning
Sun StorageTek Business Analytics Provisioning allows the administrator to:

■ Quickly locate available storage for allocation to a host server.

■ Produce reports that can be useful in performing active provisioning and 
chargeback functions in other software applications.

Storage Provisioning Wizard
The Storage Provisioning Wizard provides the following options:

■ Provision Storage and Connectivity

■ Provision Storage
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Provision Storage is the default option.

Provision Storage - Create New Request
1. Select Storage Provisioning Wizard under the Provisioning pull-down menu on 

the home page and the Step 1: Select a Provisioning Scenario window appears.

If applicable, you can select any of the last five (5) provisioning requests to copy in 
the table displayed the Provision Storage heading. Each table entry identifies the 
following information:

■ Host - Identifies the host reserved storage capacity.

■ Array Name/ID - Specifies the alias name or array ID of the array that is 
providing this volume to the server.  This is the array alias if one exists or the 
array id number if no alias exists.

■ Vol(ume) ID - The volume identifier.

■ Vol. Size/Amount Reserved - Capacity reserved (GB)

■ RAID Group - Type of RAID (e.g., RAID-1)

■ Spindles - Number of spindles

■ Protection Level - Protection level of High, Medium, or Low. High refers to 
mirrored storage. Medium refers to storage using parity RAID. Low refers to 
unprotected storage (JBOD)

■ Availability - Available or unavailable if already reserved to GSM provisioning

■ Status - Status of the storage reservation
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FIGURE 8-1 Select a Provisioning Scenario

2. To create a new request, accept the Provision Storage option (default) on the Select 
a Provisioning Scenario window and click Next>>. 

The Select a Host screen appears. This screen allows you to choose a host by typing 
the host name in the "Enter a Host Name" input field or choosing a host from the 
"Select a Host" list box. 

3. Choose the host server and click Next>>. The Select Storage Requirements 
window appears. 
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FIGURE 8-2 Select Storage Requirements

4. On the Select Storage Requirements screen, you enter the following information:

■ Amount of Storage to Allocate (in GB) - Enter the amount of storage in GB.

■ Minimum protection level desired - Use the list box to select a desired data 
protection level of High (Mirrored Storage), Medium (Parity Storage) or Low 
(Unprotected Storage). 

5. Click Next>> and the Select an Array window appears.
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FIGURE 8-3 Select an Array

This window lists storage arrays with sufficient capacity to meet the provisioning 
request at the selected data protection.  The array alias name (or array ID) the array 
model, cache, current allocation (GB) to the host, current BCV allocation to the host 
(if applicable), available capacity, available capacity for selected RAID level, front 
end controller ports, and maximum volume size (GB) are displayed for each storage 
array that can satisfy the request. The "Have GSM recommend the volumes to 
allocate from the selected array" check box is enabled by default. Remove the check 
if you want to choose from all volumes that may be used.

The message:  

The following arrays have enough storage to satisfy your request, but not at the 
appropriate protection level. Please go back and change your selections.
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appears if there are arrays with sufficient storage to fulfill the request but not at the 
requested RAID level. In this case, click Back<< to return to the Select Storage 
Requirements window and adjust the "Minimum protection level desired" setting.

6. Use the radio button to select the desired array and click Next>>. 

The Select Storage to Allocate screen appears. For the selected array, you can select 
the type of storage capacity to allocate from three types, Configured Volumes, Free 
Space in existing RAID Groups, or Unconfigured Raw Space.  A summary of 
available space and reserved capacity (if applicable) for each type of storage capacity 
appears besides its heading on the screen.

FIGURE 8-4 Select Storage to Allocate

7. Select the desired type of storage (e.g., Configured Volumes) and click Next>>. 

The next window that appears depends on whether you selected Configured 
Volumes, Free Space in RAID Groups, or Unconfigured Raw Disk Space the on the 
Select Storage To Allocate screen.



Chapter 8 Provisioning 205

■ Select Storage to Allocate - Configured Volumes - Provides a table of available 
volumes to satisfy the request. The top of the window contains text that identifies 
the requested protection level and requested capacity (in GB). The table identifies 
the Volume ID, Volume Size (GB), RAID Group, number of spindles, protection 
level, and Reservation Status is displayed for each volume.  If you checked the 
box "Have GSM recommend the volumes to allocate from the selected array" the 
Provisioning Wizard will have recommended the volumes to allocate. The bottom 
of the window identifies the number of volumes and the total allocation in GB.

■ Select Storage to Allocate - Free Space in RAID Groups  - Provides a table of free 
space configured in existing RAID groups. The top of the window contains text 
that identifies the requested protection level and requested capacity.The table lists 
the RAID Group, Protection Level, Spindles, Space Available, and Reserved. the 
window. Click the Clear Selection button to clear an existing requested capacity.

■ Select Storage to Allocate - Unconfigured Raw Disk Space - The top of the 
window contains text that identifies the requested protection level and requested 
capacity. The table identifies the Available Capacity (GB), Spindle Size(MB), 
Spindles,  Reserved Size(GB) Spindles Reserved  and RAW Capacity Required 
(GB) to satisfy the request. The Usable Amount to Reserve (GB) input box allows 
you to specify the desired amount (in GB), and the selected amount will update 
the value displayed in the Total Allocation list box at the bottom of the window. 
Click the Clear Selection button to clear an existing requested capacity.
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FIGURE 8-5 Sample Select Storage to Allocate - Configured Volumes

8. Choose the desired capacity to request and click Next>>. 

The Reserve the Selected Storage is displayed for the selected storage type, similarly 
to the one displayed below where "Free Space in RAID Groups" was previously 
chosen.
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FIGURE 8-6 Reserve the Selected Storage

9. Enter information in the following fields to define the reservation:

■ Expiration Date - Specifies the expiration date for the reservation. Click the 
Calendar icon to set the desired expiration date.

■ Comments - Enter a comment about the reservation.

■ Change Management Ticket or URL - Enter the corresponding change 
management ticket number or a link to a ticketing system if appropriate.

10. Click Finish and the Allocation Summary window is displayed. 

Click View/Print to view/print the window or Close to close the Allocation 
Summary window.
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FIGURE 8-7 Allocation Summary

Provision Storage - Copy Existing Storage 
Reservation
This section describes how you create a new storage reservation by simply copying 
one of the last five (5) existing storage reservations in the applicaton. Proceed as 
follows.

1. Select Storage Provisioning Wizard under the Provisioning menu on the home 
page to display the Select a Provisioning Scenario window. 

The window contains two options: 

■ Provision Storage and Connectivity

■ Provision Storage
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Beneath the "Provision Storage" Heading, the last 5 Provisioned Reservations table is 
displayed. For each of the last five (5) provisioned reservations, the following fields 
are displayed.

■ Array ID - The array ID of the array that is providing this volume to the server.  
This is the array alias if one exists or the array id number if no alias exists.

■ Volume ID - The volume identifier.

■ Size - Size of volume (GB)

■ RAID Group - Type of RAID (e.g., RAID-1)

■ Spindles - Number of spindles

■ Protection Level - Protection level of High, Medium, or Low. High refers to 
mirrored storage. Medium refers to storage using parity RAID. Low refers to 
unprotected storage (JBOD). 

■ Availability - Available or unavailable if already reserved.

FIGURE 8-8 Select a Provisioning Scenario with Provisioning Reservation
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2. Using the radio button, select the existing storage reservation to copy and click 
Next>>. 

The Set Capacity Requirements window for the type of storage (e.g., Configured 
Volumes) is displayed. The following steps are based on copying an existing storage 
reservation for configured volumes.

FIGURE 8-9 Set Capacity Requirements

3. Enter a different amount of storage in the "Enter amount of storage to allocate" 
input box or simply click 

Next to accept the amount in the request being copied. The Select Storage to Allocate 
- Configured Volumes is displayed for this storage type. If the copied request 
allowed Sun StorageTek Business Analytics to select the volumes, a check mark 
appears in the check box beside the respective volume’s Volume ID.
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FIGURE 8-10 Select Storage to Allocate - Configured Volumes

4. Review/change the selected volume(s) and click Next to continue. The Reserve the 
Selected Storage window appears, similar to the one displayed below.
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FIGURE 8-11 Reserved the Selected Storage

5. Enter information in the following fields to define the reservation:

■ Expiration Date - Specifies the expiration date for the reservation. Click the 
Calendar icon to set the desired expiration date.

■ Comments - Enter a comment about the reservation.

■ Change Management Ticket or URL - Enter the corresponding change 
management ticket number or a link to a ticketing system if appropriate.

6. Click Finish>> and the Allocation Summary window appears. 

The Allocation Summary window contains the details of the provisioning 
reservation at the top section of the window, including the host name, fabric name, 
and switch name. 

The bottom section of the window details the steps you perform typically to perform 
the storage provisioning.
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FIGURE 8-12 Allocation Summary

Active Provisioning Workflow
Step 1:   Open your provisioning software tool.
Step 2:  Select the array indicated above.
Step 3:  Select the Volume IDs and mask the LUNs to the host using the WWN.
Step 4: If necessary, configure local and remote replication.
Step 5: If this is the first time you have provisioned storage from this array to this 
host, create a zone that includes the array front-end port, the fabric ports, and the 
server’s HBA(s). Add the new zone to the Active Zone Set.
Step 6:  Return to GSM to update the status of your provisioning reservation. On 
the Provisioning menu, select Storage Reservations and select the reservation 
you just provisioned. Update your reservation by changing Reservation Status to 
Completed.
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7. Click View/Print to optionally view/print the window or Close to close the 
window. 

Provision Storage and Connectivity
The Provisioning Storage and Connectivity option allows you to configure a storage 
reservation for a host server including the amount and the connectivity (SAN-
attached or direct-attached).

1. Select Storage Provisioning Wizard under the Provisioning menu on the home 
page to display the Select a Provisioning Scenario window. The window contains 
two options: 

■ Provision Storage and Connectivity

■ Provision Storage

Beneath the "Provision Storage" Heading, the last 5 Provisioned Reservations table is 
displayed.

2. Using the radio button, select Provision Storage and Connectivity and click Next.

3. The Select a Host screen appears. 

This screen allows you to choose a host by typing the host name in the "Enter a Host 
Name" input field or choosing a host from the "Select a Host" list box. Because you 
are provisioning storage to a new host, use the "Site (for new hosts only)" list box to 
choose the site containing the host server’s Local Manager. Click Next to continue.
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FIGURE 8-13 Select Storage Requirements

4. The Select Storage Requirements window appears. 

Enter the amount of storage in GB. The number is checked for validity when you 
click Next>>. In addition, specify the desired minimum protection level desired 
using the list box.  The data protection levels are described below.

■ High - RAID-1 (mirroring)

■ Medium - Other RAID data protection scheme (e.g., RAID-5)

■ Low - No RAID data protection scheme

Using the respective radio box, choose to reserve SAN-attached or Direct-Attached 
storage. Optionally put a check in the check box to see all arrays at the site 
regardless of their connectivity status. Click Next to continue.

5. The Select an Array window appears if you chose SAN-attached storage. 
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FIGURE 8-14 Select an Array

This window lists storage arrays with sufficient capacity to meet the provisioning 
request at the selected data protection.  The array alias name (or array ID) the array 
model, cache, current allocation (GB) to the host, current BCV allocation to the host 
(if applicable), available capacity, available capacity for selected RAID level, front 
end controller ports, and maximum volume size (GB) are displayed for each storage 
array that can satisfy the request. The "Have GSM recommend the volumes to 
allocate from the selected array" check box is enabled by default. Remove the check 
if you want to choose from all volumes that may be used.

The message: 

appears if there are arrays with sufficient storage to fulfill the request but not at the 
requested RAID level. In this case, click Back<< to return to the Select Storage 
Requirements window and adjust the "Minimum protection level desired" setting.

The following arrays have enough storage to satisfy your request, but not at the 
appropriate protection level. Please go back and change your selections.
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Note – If you choose an array from which storage has already been allocated, the 
system displays a window that allows you to continue creating a new storage 
request or to allocate additional storage to the selected host server.

6. Use the radio button to select the desired array and click Next>>. 

The Select Storage to Allocate screen appears. For the selected array, you can select 
the type of storage capacity to allocate from three types, Configured Volumes, Free 
Space in existing RAID Groups, or Unconfigured Raw Space.  A summary of 
available space and reserved capacity (if applicable) for each type of storage capacity 
appears besides its heading on the screen.

FIGURE 8-15 Select Storage to Allocate

7. Select the desired type of storage (e.g., Configured Volumes) and click Next>>. 

The next window that appears depends on whether you selected Configured 
Volumes, Free Space in RAID Groups, or Unconfigured Raw Disk Space the on the 
Select Storage To Allocate screen.
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■ Select Storage to Allocate - Configured Volumes - Provides a table of available 
volumes to satisfy the request. The top of the window contains text that identifies 
the requested protection level and requested capacity (in GB). The table identifies 
the Volume ID, Volume Size (GB), RAID Group, number of spindles, protection 
level, and Reservation Status is displayed for each volume.  If you checked the 
box "Have GSM recommend the volumes to allocate from the selected array" the 
Provisioning Wizard will have recommended the volumes to allocate. The bottom 
of the window identifies the number of volumes and the total allocation in GB.

■ Select Storage to Allocate - Free Space in RAID Groups - Provides a table of free 
space configured in existing RAID groups. The top of the window contains text 
that identifies the requested protection level and requested capacity. The table 
lists the  RAID Group, Protection Level, Spindles, Space Available, and Reserved 
(GB). The Amount to Reserve (GB) input box allows you to specify the desired 
amount (in GB), and the selected amount will update the value displayed in the 
Total Allocation list box at the bottom of the window. Click the Clear Selection 
button to clear an existing requested capacity.

■ Select Storage to Allocate - Unconfigured Raw Disk Space - The top of the 
window contains text that identifies the requested protection level and requested 
capacity. The table identifies the Available Capacity (GB), Spindle Size (MB), 
Spindles, Reserved Size(GB) Spindles Reserved  and RAW Capacity Required 
(GB) to satisfy the request. The Usable Amount to Reserve (GB) input box allows 
you to specify the desired amount (in GB), and the selected amount will update 
the value displayed in the Total Allocation list box at the bottom of the window. 
Click the Clear Selection button to clear an existing requested capacity.

8. After you select the type of storage and click Next>>, the Select Switch Ports 
window appears for SAN-attached storage requests. 

Using the check box, select the desired fabric port and fabric switch and click 
Next>>.
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FIGURE 8-16 Select Switch Ports

9. The Reserve the Selected Storage window is displayed for the selected storage 
type, similarly to the one displayed below where "Free Space in RAID Groups" 
was previously chosen.
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FIGURE 8-17 Reserve the Selected Storage

10. Enter information in the following fields to define the reservation:

■ Expiration Date - Specifies the expiration date for the reservation. Click the 
Calendar icon to set the desired expiration date.

■ Comments - Enter a comment about the reservation.

■ Change Management Ticket or URL - Enter the corresponding change 
management ticket number or a link to a ticketing system if appropriate.

11. Click Finish and the Allocation Summary window is displayed. 

Click View/Print to view/print the window or Close to close the Allocation 
Summary window.
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Storage Reservations
Storage Reservations allows you to display all of the reservations in the system and 
allows you to view, verify, and update reservations. 

1. Select Storage Provisioning under the Provisioning pull-down menu on the home 
page.

2. Select Storage Reservations and the Storage Reservations screen appears.

3. Review the existing reservations in the system. 

Each reservation in the table is identified by the Sun StorageTek Business Analytics-
generated Reservation Number, Status, Expiration Date, Comment, and user who 
defined the reservation. This information is defined as part of creating a storage 
reservation request.

4. If reservations exist in the system, you click on a reservation number in the table 
to display the Check Reservation window. 

FIGURE 8-18 Check Reservation
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This screen provides shows the expiration date, entered by, reservation status, 
Change Management URL at the top of the window. Resources Reserved table 
identifies array details including the array ID.

The Fabric Ports table shows information (e.g., fabric name) on the fabric switch 
used for the storage allocation.

The report contains the following hyperlinks:

■ Array Id - Click to display the Detailed Array Configuration report.

■ Fabric Name - Click to display the Detailed Fabric Configuration report.

■ Switch Name - Click to display the Detailed Switch Configuration report.

5. To update an existing reservation in the system:

a. Click Update on the Check Reservations screen.

b. Enter the reservation number when prompted or select the reservation from the 
pull-down list.

c. Modify the Expiration Date or Status (Open, Completed, Cancelled, 
Incomplete).

6. Click Update to commit the changes.

Select the "Go to Detailed" Provisioning Steps" button to display the Provisioning 
Reservation Detail window.
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CHAPTER 9

Help

This chapter describes the different reports available through the Sun StorageTek 
Business Analytics Management Console’s Help pull down menu.

Content and Index
Use Context/Index to launch the Management Console help engine. The Contents 
functionality allows you to choose displaying help information based on the 
individual types of Sun StorageTek Business Analytics reports. Index displays an 
index of important terms in the help engine.

The help engine also provides a search capability to allow you to query the help 
repository based on your input.

About Business Analytics
The About Business Analytics report provides the software version information for 
the Management Console and Database software components. This information may 
be useful for troubleshooting or planning a Sun StorageTek Business Analytics 
software upgrade.

Click Database Upgrade History to view the Central Manager Database upgrade 
history:

■ Software version

■ Action (install or upgrade)

■ Date and time the software install or upgrade occurred
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